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Fuzzy Logic Toolbox Product Description

Design and simulate fuzzy logic systems

1-2

Fuzzy Logic Toolbox provides MATLAB® functions, apps, and a Simulink® block for
analyzing, designing, and simulating systems based on fuzzy logic. The product guides
you through the steps of designing fuzzy inference systems. Functions are provided for
many common methods, including fuzzy clustering and adaptive neurofuzzy learning.

The toolbox lets you model complex system behaviors using simple logic rules, and then
implement these rules in a fuzzy inference system. You can use it as a stand-alone fuzzy
inference engine. Alternatively, you can use fuzzy inference blocks in Simulink and

simulate the fuzzy systems within a comprehensive model of the entire dynamic system.

Key Features

Fuzzy Logic Design app for building fuzzy inference systems and viewing and
analyzing results

Membership functions for creating fuzzy inference systems
Support for AND, OR, and NOT logic in user-defined rules
Standard Mamdani and Sugeno-type fuzzy inference systems

Automated membership function shaping through neuroadaptive and fuzzy clustering
learning techniques

Ability to embed a fuzzy inference system in a Simulink model

Ability to generate embeddable C code or stand-alone executable fuzzy inference
engines
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What Is Fuzzy Logic?

Description of Fuzzy Logic

In recent years, the number and variety of applications of fuzzy logic have increased
significantly. The applications range from consumer products such as cameras,
camcorders, washing machines, and microwave ovens to industrial process control,
medical instrumentation, decision-support systems, and portfolio selection.

To understand why use of fuzzy logic has grown, you must first understand what is meant
by fuzzy logic.

Fuzzy logic has two different meanings. In a narrow sense, fuzzy logic is a logical system,
which is an extension of multivalued logic. However, in a wider sense fuzzy logic (FL) is
almost synonymous with the theory of fuzzy sets, a theory which relates to classes of
objects with unsharp boundaries in which membership is a matter of degree. In this
perspective, fuzzy logic in its narrow sense is a branch of FL. Even in its more narrow
definition, fuzzy logic differs both in concept and substance from traditional multivalued
logical systems.

In Fuzzy Logic Toolbox software, fuzzy logic should be interpreted as FL, that is, fuzzy
logic in its wide sense. The basic ideas underlying FL are explained in “Foundations of
Fuzzy Logic” on page 1-10. What might be added is that the basic concept underlying FL
is that of a linguistic variable, that is, a variable whose values are words rather than
numbers. In effect, much of FL may be viewed as a methodology for computing with
words rather than numbers. Although words are inherently less precise than numbers,
their use is closer to human intuition. Furthermore, computing with words exploits the
tolerance for imprecision and thereby lowers the cost of solution.

Another basic concept in FL, which plays a central role in most of its applications, is that
of a fuzzy if-then rule or, simply, fuzzy rule. Although rule-based systems have a long
history of use in Artificial Intelligence (AI), what is missing in such systems is a
mechanism for dealing with fuzzy consequents and fuzzy antecedents. In fuzzy logic, this
mechanism is provided by the calculus of fuzzy rules. The calculus of fuzzy rules serves as
a basis for what might be called the Fuzzy Dependency and Command Language (FDCL).
Although FDCL is not used explicitly in the toolbox, it is effectively one of its principal
constituents. In most of the applications of fuzzy logic, a fuzzy logic solution is, in reality,
a translation of a human solution into FDCL.

A trend that is growing in visibility relates to the use of fuzzy logic in combination with
neurocomputing and genetic algorithms. More generally, fuzzy logic, neurocomputing,
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and genetic algorithms may be viewed as the principal constituents of what might be
called soft computing. Unlike the traditional, hard computing, soft computing
accommodates the imprecision of the real world. The guiding principle of soft computing
is: Exploit the tolerance for imprecision, uncertainty, and partial truth to achieve
tractability, robustness, and low solution cost. In the future, soft computing could play an
increasingly important role in the conception and design of systems whose MIQ (Machine
1Q) is much higher than that of systems designed by conventional methods.

Among various combinations of methodologies in soft computing, the one that has highest
visibility at this juncture is that of fuzzy logic and neurocomputing, leading to neuro-fuzzy
systems. Within fuzzy logic, such systems play a particularly important role in the
induction of rules from observations. An effective method developed by Dr. Roger Jang for
this purpose is called ANFIS (Adaptive Neuro-Fuzzy Inference System). This method is an
important component of the toolbox.

Fuzzy logic is all about the relative importance of precision: How important is it to be
exactly right when a rough answer will do?

You can use Fuzzy Logic Toolbox software with MATLAB technical computing software as
a tool for solving problems with fuzzy logic. Fuzzy logic is a fascinating area of research
because it does a good job of trading off between significance and precision — something
that humans have been managing for a very long time.

In this sense, fuzzy logic is both old and new because, although the modern and
methodical science of fuzzy logic is still young, the concepts of fuzzy logic relies on age-
old skills of human reasoning.



What Is Fuzzy Logic?

Precision and Significance in the Real World I

A 1500 kg mass ‘ ‘
is approaching

your head at
45.3 m/s

5 ER Spp. IS &

Precision Significance

Fuzzy logic is a convenient way to map an input space to an output space. Mapping input
to output is the starting point for everything. Consider the following examples:

» With information about how good your service was at a restaurant, a fuzzy logic
system can tell you what the tip should be.

» With your specification of how hot you want the water, a fuzzy logic system can adjust
the faucet valve to the right setting.

* With information about how far away the subject of your photograph is, a fuzzy logic
system can focus the lens for you.

* With information about how fast the car is going and how hard the motor is working, a
fuzzy logic system can shift gears for you.

A graphical example of an input-output map is shown in the following figure.
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Input Space Output Space
(algﬂ(;ﬁf;/brlaetiiegrsv)lce (all possible tips)

the "right" tip
for tonight

tonight's service
quality

An input-output map for the tipping problem:
“Given the quality of service, how much should | tip?”

Determining the appropriate amount of tip requires mapping inputs to the appropriate
outputs. Between the input and the output, the preceding figure shows a black box that
can contain any number of things: fuzzy systems, linear systems, expert systems, neural
networks, differential equations, interpolated multidimensional lookup tables, or even a
spiritual advisor, just to name a few of the possible options. Clearly the list could go on
and on.

Of the dozens of ways to make the black box work, it turns out that fuzzy is often the very
best way. Why should that be? As Lotfi Zadeh, who is considered to be the father of fuzzy
logic, once remarked: "In almost every case you can build the same product without fuzzy
logic, but fuzzy is faster and cheaper."

Why Use Fuzzy Logic?
Here is a list of general observations about fuzzy logic:
* Fuzzy logic is conceptually easy to understand.

The mathematical concepts behind fuzzy reasoning are very simple. Fuzzy logic is a
more intuitive approach without the far-reaching complexity.

» Fuzzy logic is flexible.
With any given system, it is easy to layer on more functionality without starting again
from scratch.

» Fuzzy logic is tolerant of imprecise data.
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Everything is imprecise if you look closely enough, but more than that, most things are
imprecise even on careful inspection. Fuzzy reasoning builds this understanding into
the process rather than tacking it onto the end.

» Fuzzy logic can model nonlinear functions of arbitrary complexity.

You can create a fuzzy system to match any set of input-output data. This process is
made particularly easy by adaptive techniques like Adaptive Neuro-Fuzzy Inference
Systems (ANFIS), which are available in Fuzzy Logic Toolbox software.

» Fuzzy logic can be built on top of the experience of experts.

In direct contrast to neural networks, which take training data and generate opaque,
impenetrable models, fuzzy logic lets you rely on the experience of people who already
understand your system.

» Fuzzy logic can be blended with conventional control techniques.

Fuzzy systems don't necessarily replace conventional control methods. In many cases
fuzzy systems augment them and simplify their implementation.

* Fuzzy logic is based on natural language.

The basis for fuzzy logic is the basis for human communication. This observation
underpins many of the other statements about fuzzy logic. Because fuzzy logic is built
on the structures of qualitative description used in everyday language, fuzzy logic is
easy to use.

The last statement is perhaps the most important one and deserves more discussion.
Natural language, which is used by ordinary people on a daily basis, has been shaped by
thousands of years of human history to be convenient and efficient. Sentences written in
ordinary language represent a triumph of efficient communication.

When Not to Use Fuzzy Logic

Fuzzy logic is not a cure-all. When should you not use fuzzy logic? The safest statement is
the first one made in this introduction: fuzzy logic is a convenient way to map an input
space to an output space. If you find it's not convenient, try something else. If a simpler
solution already exists, use it. Fuzzy logic is the codification of common sense — use
common sense when you implement it and you will probably make the right decision.
Many controllers, for example, do a fine job without using fuzzy logic. However, if you
take the time to become familiar with fuzzy logic, you'll see it can be a very powerful tool
for dealing quickly and efficiently with imprecision and nonlinearity.

1-7
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What Can Fuzzy Logic Toolbox Software Do?

You can create and edit fuzzy inference systems with Fuzzy Logic Toolbox software. You
can create these systems using graphical tools or command-line functions, or you can
generate them automatically using either clustering or adaptive neuro-fuzzy techniques.

If you have access to Simulink software, you can easily test your fuzzy system in a block
diagram simulation environment.

The toolbox also lets you run your own stand-alone C programs directly. This is made
possible by a stand-alone Fuzzy Inference Engine that reads the fuzzy systems saved from
a MATLAB session. You can customize the stand-alone engine to build fuzzy inference into
your own code. All provided code is ANSI® compliant.

Fuzzy ;
Fuzzy Logic |||
Inference \--- Toolbox
System  \-:..----

\simulink

User-written
M-files

Other toolboxes

MATLAB

\

Because of the integrated nature of the MATLAB environment, you can create your own
tools to customize the toolbox or harness it with another toolbox, such as the Control
System Toolbox™, Deep Learning Toolbox™, or Optimization Toolbox™ software.
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More About

. “Foundations of Fuzzy Logic” on page 1-10
. “Fuzzy vs. Nonfuzzy Logic” on page 1-47
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Foundations of Fuzzy Logic

Overview

The point of fuzzy logic is to map an input space to an output space, and the primary
mechanism for doing this is a list of if-then statements called rules. All rules are evaluated
in parallel, and the order of the rules is unimportant. The rules themselves are useful
because they refer to variables and the adjectives that describe those variables. Before
you can build a system that interprets rules, you must define all the terms you plan on
using and the adjectives that describe them. To say that the water is hot, you need to
define the range that the water's temperature can be expected to vary as well as what we
mean by the word hot. The following diagram provides a roadmap for the fuzzy inference
process. It shows the general description of a fuzzy system on the left and a specific fuzzy
system on the right.

The General Case A Specific Example

Input === Output service === tip

¥

Rules

N

¥

if service is poor then tip is cheap
if service is good then tip is average
if service is excellent then tip is generous

N

Input Output service tip
terms terms is interpreted as is assigned to be
. . {poor, {cheap,
(interpret) (assign) good, average,
excellent} generous}

To summarize the concept of fuzzy inference depicted in this figure, fuzzy inference is a
method that interprets the values in the input vector and, based on some set of rules,
assigns values to the output vector.

This topic guides you through the fuzzy logic process step by step by providing an
introduction to the theory and practice of fuzzy logic.

1-10
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Fuzzy Sets

Fuzzy logic starts with the concept of a fuzzy set. A fuzzy set is a set without a crisp,
clearly defined boundary. It can contain elements with only a partial degree of
membership.

To understand what a fuzzy set is, first consider the definition of a classical set. A
classical set is a container that wholly includes or wholly excludes any given element. For
example, the set of days of the week unquestionably includes Monday, Thursday, and
Saturday. It just as unquestionably excludes butter, liberty, and dorsal fins, and so on.

Shoe .
Polish Monday Liberty
Thursday
Saturday Dorsal
Butter Fins

Days of the week

This type of set is called a classical set because it has been around for a long time. It was
Aristotle who first formulated the Law of the Excluded Middle, which says X must either
be in set A or in set not-A. Another version of this law is:

Of any subject, one thing must be either asserted or denied.

To restate this law with annotations: "Of any subject (say Monday), one thing (a day of the
week) must be either asserted or denied (I assert that Monday is a day of the week)." This
law demands that opposites, the two categories A and not-A, should between them
contain the entire universe. Everything falls into either one group or the other. There is
no thing that is both a day of the week and not a day of the week.

Now, consider the set of days comprising a weekend. The following diagram attempts to
classify the weekend days.

1-11
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Shoe Liberty
Polish
Monday
Sunday
Dorsal
Butter Fins

Days of the weekend

Most would agree that Saturday and Sunday belong, but what about Friday? It feels like a
part of the weekend, but somehow it seems like it should be technically excluded. Thus, in
the preceding diagram, Friday tries its best to "straddle on the fence." Classical or normal
sets would not tolerate this kind of classification. Either something is in or it is out.
Human experience suggests something different, however, straddling the fence is part of
life.

Of course individual perceptions and cultural background must be taken into account
when you define what constitutes the weekend. Even the dictionary is imprecise, defining
the weekend as the period from Friday night or Saturday to Monday morning. You are
entering the realm where sharp-edged, yes-no logic stops being helpful. Fuzzy reasoning
becomes valuable exactly when you work with how people really perceive the concept
weekend as opposed to a simple-minded classification useful for accounting purposes
only. More than anything else, the following statement lays the foundations for fuzzy
logic.

In fuzzy logic, the truth of any statement becomes a matter of degree.

Any statement can be fuzzy. The major advantage that fuzzy reasoning offers is the ability
to reply to a yes-no question with a not-quite-yes-or-no answer. Humans do this kind of
thing all the time (think how rarely you get a straight answer to a seemingly simple
question), but it is a rather new trick for computers.

How does it work? Reasoning in fuzzy logic is just a matter of generalizing the familiar
yes-no (Boolean) logic. If you give true the numerical value of 1 and false the numerical
value of 0, this value indicates that fuzzy logic also permits in-between values like 0.2 and
0.7453. For instance:

Q: Is Saturday a weekend day?
A: 1 (yes, or true)
Q: Is Tuesday a weekend day?
A: 0 (no, or false)
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Q: Is Friday a weekend day?

A: 0.8 (for the most part yes, but not completely)
Q: Is Sunday a weekend day?

A: 0.95 (yes, but not quite as much as Saturday).

The following plot on the left shows the truth values for weekend-ness if you are forced to
respond with an absolute yes or no response. On the right, is a plot that shows the truth
value for weekend-ness if you are allowed to respond with fuzzy in-between values.

weekend-ness
weekend-ness

I
I
u
=

""""""" S B IR m—
Thursday  Friday Saturday Sunday Monday Thursday  Friday Saturday Sunday Monday

Days of the weekend two-valued membership Days of the weekend multivalued membership

Technically, the representation on the right is from the domain of multivalued logic (or
multivalent logic). If you ask the question "Is X a member of set A?" the answer might be
yes, no, or any one of a thousand intermediate values in between. Thus, X might have
partial membership in A. Multivalued logic stands in direct contrast to the more familiar
concept of two-valued (or bivalent yes-no) logic.

To return to the example, now consider a continuous scale time plot of weekend-ness
shown in the following plots.

1.0
@
@
=
°
=
Q
<
[
9]
H
0.0
Thursday Friday Saturday Sunday Monday Thursday Friday Saturday Sunday Monday
Days of the weekend two-valued membership Days of the weekend multivalued membership

By making the plot continuous, you are defining the degree to which any given instant
belongs in the weekend rather than an entire day. In the plot on the left, notice that at
midnight on Friday, just as the second hand sweeps past 12, the weekend-ness truth value
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jumps discontinuously from 0 to 1. This is one way to define the weekend, and while it
may be useful to an accountant, it may not really connect with your own real-world
experience of weekend-ness.

The plot on the right shows a smoothly varying curve that accounts for the fact that all of
Friday, and, to a small degree, parts of Thursday, partake of the quality of weekend-ness
and thus deserve partial membership in the fuzzy set of weekend moments. The curve
that defines the weekend-ness of any instant in time is a function that maps the input
space (time of the week) to the output space (weekend-ness). Specifically it is known as a
membership function. See “Membership Functions” on page 1-14 for a more detailed
discussion.

As another example of fuzzy sets, consider the question of seasons. What season is it right
now? In the northern hemisphere, summer officially begins at the exact moment in the
earth's orbit when the North Pole is pointed most directly toward the sun. It occurs
exactly once a year, in late June. Using the astronomical definitions for the season, you
get sharp boundaries as shown on the left in the figure that follows. But what you
experience as the seasons vary more or less continuously as shown on the right in the
following figure (in temperate northern hemisphere climates).

1.0 sprin summer fall winter 10 sprin summer fall winter
degree degree
of of
member- member-
ship ship
0.0 0.0

March June September December  March March June September December  March
Time of the Time of the
year year

Membership Functions

A membership function (MF) is a curve that defines how each point in the input space is
mapped to a membership value (or degree of membership) between 0 and 1. The input
space is sometimes referred to as the universe of discourse, a fancy name for a simple
concept.

One of the most commonly used examples of a fuzzy set is the set of tall people. In this
case, the universe of discourse is all potential heights, say from three feet to nine feet,
and the word tall would correspond to a curve that defines the degree to which any
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person is tall. If the set of tall people is given the well-defined (crisp) boundary of a
classical set, you might say all people taller than six feet are officially considered tall.
However, such a distinction is clearly absurd. It may make sense to consider the set of all
real numbers greater than six because numbers belong on an abstract plane, but when
we want to talk about real people, it is unreasonable to call one person short and another
one tall when they differ in height by the width of a hair.

excellent!
.

You must be
taller than
this line to

be
considered

TALL

If the kind of distinction shown previously is unworkable, then what is the right way to
define the set of tall people? Much as with the plot of weekend days, the figure following
shows a smoothly varying curve that passes from not-tall to tall. The output-axis is a
number known as the membership value between 0 and 1. The curve is known as a
membership function and is often given the designation of . This curve defines the
transition from not tall to tall. Both people are tall to some degree, but one is significantly
less tall than the other.
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: e tall =1.0
10 sharp-edged (u )
membership
degree of function for
membership, p TALL
0.0 not tall (1 = 0.0)
height
1.0 continuous definitely a tall
membership person (u = 0.95)
degree of function for

membership, p TALL

really not very
tall at all (n = 0.30)

0.0

height

@)

¢

Subjective interpretations and appropriate units are built right into fuzzy sets. If you say
"She's tall," the membership function tall should already take into account whether you
are referring to a six-year-old or a grown woman. Similarly, the units are included in the
curve. Certainly it makes no sense to say "Is she tall in inches or in meters?"

Membership Functions in Fuzzy Logic Toolbox Software

The only condition a membership function must really satisfy is that it must vary between
0 and 1. The function itself can be an arbitrary curve whose shape we can define as a
function that suits us from the point of view of simplicity, convenience, speed, and
efficiency.

A classical set might be expressed as
A={x|x>6}

A fuzzy set is an extension of a classical set. If X is the universe of discourse and its
elements are denoted by x, then a fuzzy set A in X is defined as a set of ordered pairs.
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A{x, pa(x)|x € X}
A= {x, pax¥) | x € X}

Ua(x) is called the membership function (or MF) of x in A. The membership function maps
each element of X to a membership value between 0 and 1.

The toolbox includes 11 built-in membership function types. These 11 functions are, in
turn, built from several basic functions:

* Piece-wise linear functions

* Gaussian distribution function

* Sigmoid curve

* Quadratic and cubic polynomial curves

For detailed information on any of the membership functions mentioned next, see the
corresponding reference page.

The simplest membership functions are formed using straight lines. Of these, the simplest
is the triangular membership function, and it has the function name trimf. This function
is nothing more than a collection of three points forming a triangle. The trapezoidal
membership function, trapmf, has a flat top and really is just a truncated triangle curve.
These straight line membership functions have the advantage of simplicity.

1r 1ir

0.75 0.751
0.5f 0.5F

0.251 0.25F

trimf, P =[3 6 8] trapmf, P=[157 8]

trimf trapmf

Two membership functions are built on the Gaussian distribution curve: a simple
Gaussian curve and a two-sided composite of two different Gaussian curves. The two
functions are gaussmf and gauss2mf.

The generalized bell membership function is specified by three parameters and has the
function name gbellmf. The bell membership function has one more parameter than the
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Gaussian membership function, so it can approach a non-fuzzy set if the free parameter is
tuned. Because of their smoothness and concise notation, Gaussian and bell membership
functions are popular methods for specifying fuzzy sets. Both of these curves have the
advantage of being smooth and nonzero at all points.

0 2 8 10 0 2 8 10 0 2 8 10

4 6 4 6 4 6
gaussmf, P =[2 5] gauss2mf, P =133 4] gbellmf, P =2 4 6]

gaussmf gauss2mf gbellmf

Although the Gaussian membership functions and bell membership functions achieve
smoothness, they are unable to specify asymmetric membership functions, which are
important in certain applications. Next, you define the sigmoidal membership function,
which is either open left or right. Asymmetric and closed (i.e. not open to the left or right)
membership functions can be synthesized using two sigmoidal functions, so in addition to
the basic sigmf, you also have the difference between two sigmoidal functions, dsigmf,
and the product of two sigmoidal functions psigmf.

0 2 4 6 8 10 0 2

4 6 8 10 0 2
siamf. P =12 41 dsiamf. P=[5257]

4 6
psiamf, P =[23 -5 8]

sigmf dsigmf psigmf

Polynomial based curves account for several of the membership functions in the toolbox.
Three related membership functions are the Z, S, andPi curves, all named because of
their shape. The function zmf is the asymmetrical polynomial curve open to the left, smf
is the mirror-image function that opens to the right, and pimf is zero on both extremes
with a rise in the middle.
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0 2 4 6 8 10 0 2 4 6 8 10 0 2 4 6 8 10
zmf, P=1371 pimf, P =145 101 smf, P =[18]

zmf pimf smf

There is a very wide selection to choose from when you're selecting a membership
function. You can also create your own membership functions with the toolbox. However,
if a list based on expanded membership functions seems too complicated, just remember
that you could probably get along very well with just one or two types of membership
functions, for example the triangle and trapezoid functions. The selection is wide for
those who want to explore the possibilities, but expansive membership functions are not
necessary for good fuzzy inference systems. Finally, remember that more details are
available on all these functions in the reference section.

Summary of Membership Functions

» Fuzzy sets describe vague concepts (e.g., fast runner, hot weather, weekend days).

* A fuzzy set admits the possibility of partial membership in it. (e.g., Friday is sort of a
weekend day, the weather is rather hot).

* The degree an object belongs to a fuzzy set is denoted by a membership value between
0 and 1. (e.g., Friday is a weekend day to the degree 0.8).

* A membership function associated with a given fuzzy set maps an input value to its
appropriate membership value.

Logical Operations

Now that you understand the fuzzy inference, you need to see how fuzzy inference
connects with logical operations.

The most important thing to realize about fuzzy logical reasoning is the fact that it is a
superset of standard Boolean logic. In other words, if you keep the fuzzy values at their
extremes of 1 (completely true), and 0 (completely false), standard logical operations will
hold. As an example, consider the following standard truth tables.
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A B AandB A B AorB A not A
0 0 0 0 0 0 0 1
0 1 0 0 1 1 1 0
1 0 0 1 0 1
1 1 1 1 1 1

AND OR NOT

Now, because in fuzzy logic the truth of any statement is a matter of degree, can these
truth tables be altered? The input values can be real numbers between 0 and 1. What
function preserves the results of the AND truth table (for example) and also extend to all
real numbers between 0 and 1?

One answer is the min operation. That is, resolve the statement A AND B, where A and B
are limited to the range (0,1), by using the function min(A,B). Using the same reasoning,
you can replace the OR operation with the max function, so that A OR B becomes
equivalent to max(A,B). Finally, the operation NOT A becomes equivalent to the operation
1 — A. Notice how the previous truth table is completely unchanged by this substitution.

A B min(A,B) A B max(A,B) A 1-A
0 0 0 0 0 0 0
0 1 0 0 1 1
1 0 0 1 0 1
1 1 1 1 1 1
AND OR NOT

Moreover, because there is a function behind the truth table rather than just the truth
table itself, you can now consider values other than 1 and 0.

The next figure uses a graph to show the same information. In this figure, the truth table
is converted to a plot of two fuzzy sets applied together to create one fuzzy set. The upper
part of the figure displays plots corresponding to the preceding two-valued truth tables,
while the lower part of the figure displays how the operations work over a continuously
varying range of truth values A and B according to the fuzzy operations you have defined.
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A A A
B B
Two-valued —
logic —_—
AorB
A and B not A
% \ N /A
Multivalued
|OgIC AorB
not A
A and B/\ \

AND OR NOT

min(A,B) max(A,B) (1-A)

Given these three functions, you can resolve any construction using fuzzy sets and the
fuzzy logical operation AND, OR, and NOT.

Additional Fuzzy Operators

In this case, you defined only one particular correspondence between two-valued and
multivalued logical operations for AND, OR, and NOT. This correspondence is by no
means unique.

In more general terms, you are defining what are known as the fuzzy intersection or
conjunction (AND), fuzzy union or disjunction (OR), and fuzzy complement (NOT). The
classical operators for these functions are: AND = min, OR = max, and NOT = additive
complement. Typically, most fuzzy logic applications make use of these operations and
leave it at that. In general, however, these functions are arbitrary to a surprising degree.
Fuzzy Logic Toolbox software uses the classical operator for the fuzzy complement as
shown in the previous figure, but also enables you to customize the AND and OR
operators.

The intersection of two fuzzy sets A and B is specified in general by a binary mapping T,
which aggregates two membership functions as follows:

B n B(X) = T(1a(x), pp(x))
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For example, the binary operator T may represent the multiplication of u,(x) and up(x).
These fuzzy intersection operators, which are usually referred to as T-norm (Triangular
norm) operators, meet the following basic requirements:

A T-norm operator is a binary mapping T(.,.) with the following properties:

* Boundary — T(0,0)=0, T(a,1) =T(1,a) =a

* Monotonicity — T(a,b) = T(c,d)ifa<scand b =d

* Commutativity — T(a, b) = T(b, a)

* Associativity — T(a, T(b, c)) = T(T(a, b), ¢)

The first requirement imposes the correct generalization to crisp sets. The second
requirement implies that a decrease in the membership values in A or B cannot produce
an increase in the membership value in A intersection B. The third requirement indicates
that the operator is indifferent to the order of the fuzzy sets to be combined. Finally, the

fourth requirement allows us to take the intersection of any number of sets in any order
of pair-wise groupings.

Like fuzzy intersection, the fuzzy union operator is specified in general by a binary
mapping S:

v B(X) = S(na(x), uB(X))

For example, the binary operator S can represent the addition of u,(x) and pgp(x). These
fuzzy union operators, which are often referred to as T-conorm (or S-norm) operators,
must satisfy the following basic requirements:

A T-conorm (or S-norm) operator is a binary mapping S(.,.) with the following properties:

* Boundary — S(1,1) =1, S(a,0) = 5(0,a) = a

* Monotonicity — S(a,b) = S(c,d)ifa<cand b =d

* Commutativity — S(a, b) = S(b, a)

* Associativity — S(a, S(b, ¢)) = S(S(a, b), ¢)

Several parameterized T-norms and dual T-conorms have been proposed in the past, such
as those of Yager [10], Dubois and Prade [1], Schweizer and Sklar [7], and Sugeno [8].

Each of these provides a way to vary the gain on the function so that it can be very
restrictive or very permissive.
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If-Then Rules

Fuzzy sets and fuzzy operators are the subjects and verbs of fuzzy logic. These if-then rule
statements are used to formulate the conditional statements that comprise fuzzy logic.

A single fuzzy if-then rule assumes the form
IfxisA, thenyis B

where A and B are linguistic values defined by fuzzy sets on the ranges (universes of
discourse) X and Y, respectively. The if-part of the rule "x is A" is called the antecedent or
premise, while the then-part of the rule "y is B" is called the consequent or conclusion. An
example of such a rule might be

If service is good then tip is average

The concept good is represented as a number between 0 and 1, and so the antecedent is
an interpretation that returns a single number between 0 and 1. Conversely, average is
represented as a fuzzy set, and so the consequent is an assignment that assigns the entire
fuzzy set B to the output variable y. In the if-then rule, the word is gets used in two
entirely different ways depending on whether it appears in the antecedent or the
consequent. In MATLAB terms, this usage is the distinction between a relational test
using "=="and a variable assignment using the "=" symbol. A less confusing way of
writing the rule would be

If service == good, then tip = average

In general, the input to an if-then rule is the current value for the input variable (in this
case, service) and the output is an entire fuzzy set (in this case, average). This set will
later be defuzzified, assigning one value to the output. The concept of defuzzification is
described in the next section.

Interpreting an if-then rule involves two steps:

» Evaluation of the antecedent — Fuzzifying the inputs and applying any necessary fuzzy
operators.

» Application of the result to the consequent.
The second step is known as implication. For an if-then rule, the antecedent, p, implies
the consequent, g. In binary logic, if p is true, then q is also true (p — q). In fuzzy logic, if

p is true to some degree of membership, then q is also true to the same degree (0.5p =
0.5q). In both cases, if p is false, then the value of g is undetermined.
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The antecedent of a rule can have multiple parts.
If sky is gray and wind is strong and barometer is falling, then ...

In this case all parts of the antecedent are calculated simultaneously and resolved to a
single number using the logical operators described in the preceding section. The
consequent of a rule can also have multiple parts.

If temperature is cold, then hot water valve is open and cold water valve is shut

In this case, all consequents are affected equally by the result of the antecedent. How is
the consequent affected by the antecedent? The consequent specifies a fuzzy set be
assigned to the output. The implication function then modifies that fuzzy set to the degree
specified by the antecedent. The most common ways to modify the output fuzzy set are
truncation using the min function (where the fuzzy set is truncated as shown in the
following figure) or scaling using the prod function (where the output fuzzy set is
squashed). Both are supported by the toolbox, but you use truncation for the examples in
this section.
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Antecedent Consequent

— N ——

If service is excellent or  food is delicious then tip = generous

excellent delcious Cﬁ>
1. Fuzzify > m _/

|npUtS service (crisp) food (crisp)

M(service==excellent) = 0 .0 M(food==delicious) = 0 .7

If ( 0.0 or then tip = generous
2. Apply
OR operator
(max)
max(0.0, 0.7) = 0.7
If ( 07 ) then tip = generous

3. Apply
implication 07 5 | .
Operator (mln) - generous /-\

min(0.7, generous)

Summary of If-Then Rules

Interpreting if-then rules is a three-part process. This process is explained in detail in the
next section:

1 Fuzzify inputs: Resolve all fuzzy statements in the antecedent to a degree of
membership between 0 and 1. If there is only one part to the antecedent, then this is
the degree of support for the rule.

2  Apply fuzzy operator to multiple part antecedents: If there are multiple parts to
the antecedent, apply fuzzy logic operators and resolve the antecedent to a single
number between 0 and 1. This is the degree of support for the rule.

3 Apply implication method: Use the degree of support for the entire rule to shape
the output fuzzy set. The consequent of a fuzzy rule assigns an entire fuzzy set to the
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output. This fuzzy set is represented by a membership function that is chosen to
indicate the qualities of the consequent. If the antecedent is only partially true, (i.e.,
is assigned a value less than 1), then the output fuzzy set is truncated according to
the implication method.

In general, one rule alone is not effective. Two or more rules that can play off one another
are needed. The output of each rule is a fuzzy set. The output fuzzy sets for each rule are
then aggregated into a single output fuzzy set. Finally the resulting set is defuzzified, or
resolved to a single number. “Build Fuzzy Systems Using Fuzzy Logic Designer” on page
2-14 shows how the whole process works from beginning to end for a particular type of
fuzzy inference system called a Mamdani type.
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Fuzzy Inference Process

Fuzzy inference is the process of formulating the mapping from a given input to an output
using fuzzy logic. The mapping then provides a basis from which decisions can be made,
or patterns discerned. The process of fuzzy inference involves all the pieces that are
described in “Membership Functions” on page 1-14, “Logical Operations” on page 1-19,
and “If-Then Rules” on page 1-23.

This section describes the fuzzy inference process and uses the example of the two-input,
one-output, three-rule tipping problem from “The Basic Tipping Problem” on page 2-16.
The basic structure of this example is shown in the following diagram:

Dinner for Two
a 2 input, 1 output, 3 rule system

Rule 1 If ser\{icg is poor or food is rancid,
then tip is cheap.

Input 1
Service (0-10)

Rule 2 If service is good, then tip is average.

Input 2
Food (0-10)
Rule 3 If sgfvice is excgllgnt or food is
delicious, then tip is generous.

Output
Tip (5-25%)

The inputs are crisp All rules are The results of the The resultis a
(non-fuzzy) evaluated in parallel rules are combined crisp (non-fuzzy)
numbers limited to a using fuzzy and distilled number.

specific range. reasoning. (defuzzified).

Information flows from left to right, from two inputs to a single output. The parallel
nature of the rules is an important aspect of fuzzy logic systems. Instead of sharp
switching between modes based on breakpoints, logic flows smoothly from regions where
one rule or another dominates.

Fuzzy inference process comprises of five parts:

» Fuzzification of the input variables on page 1-29
* Application of the fuzzy operator (AND or OR) in the antecedent on page 1-30
* Implication from the antecedent to the consequent on page 1-31
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* Aggregation of the consequents across the rules on page 1-31
» Defuzzification on page 1-33

A fuzzy inference diagram on page 1-34 displays all parts of the fuzzy inference process
— from fuzzification through defuzzification.

Fuzzify Inputs

The first step is to take the inputs and determine the degree to which they belong to each
of the appropriate fuzzy sets via membership functions. In Fuzzy Logic Toolbox software,
the input is always a crisp numerical value limited to the universe of discourse of the
input variable (in this case, the interval from 0 through 10) . The output is a fuzzy degree
of membership in the qualifying linguistic set (always the interval from 0 through 1).
Fuzzification of the input amounts to either a table lookup or a function evaluation.

This example is built on three rules, and each of the rules depends on resolving the inputs
into several different fuzzy linguistic sets: service is poor, service is good, food is rancid,
food is delicious, and so on. Before the rules can be evaluated, the inputs must be
fuzzified according to each of these linguistic sets. For example, to what extent is the food
delicious? The following figure shows how well the food at the hypothetical restaurant
(rated on a scale from 0 through 10) qualifies as the linguistic variable delicious using a
membership function. In this case, we rate the food as an 8, which, given the graphical
definition of delicious, corresponds to u = 0.7 for the delicious membership function.

1. Fuzzify

inputs. delicious Result of
fuzzification

food is delicious |

food =8

input

In this manner, each input is fuzzified over all the qualifying membership functions
required by the rules.
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Apply Fuzzy Operator

After the inputs are fuzzified, you know the degree to which each part of the antecedent
is satisfied for each rule. If the antecedent of a rule has more than one part, the fuzzy
operator is applied to obtain one number that represents the result of the rule
antecedent. This number is then applied to the output function. The input to the fuzzy
operator is two or more membership values from fuzzified input variables. The output is a
single truth value.

As is described in “Logical Operations” on page 1-19 section, any number of well-defined
methods can fill in for the AND operation or the OR operation. In the toolbox, two built-in
AND methods are supported: min (minimum) and prod (product). Two built-in OR
methods are also supported: max (maximum), and the probabilistic OR method probor.
The probabilistic OR method (also known as the algebraic sum) is calculated according to
the equation:

probor(a,b) =a + b - ab

In addition to these built-in methods, you can create your own methods for AND and OR
by writing any function and setting that to be your method of choice.

The following figure shows the OR operator max at work, evaluating the antecedent of the
rule 3 for the tipping calculation. The two different pieces of the antecedent (service is
excellent and food is delicious) yielded the fuzzy membership values 0.0 and 0.7
respectively. The fuzzy OR operator simply selects the maximum of the two values, 0.7,
and the fuzzy operation for rule 3 is complete. The probabilistic OR method would still
result in 0.7.

1. Fuzzify 2. Apply
inputs. OR operator (max).
excellent 0.7
0.7
0.0 delicious 0.0 result of
fuzzy operator
service is excellent or food is delicious

service =3 food = 8

input 1 input 2
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Apply Implication Method

Before applying the implication method, you must determine the rule weight. Every rule
has a weight (a number from 0 through 1), which is applied to the number given by the
antecedent. Generally, this weight is 1 (as it is for this example) and thus has no effect on
the implication process. However, you can decrease the effect of one rule relative to the
others by changing its weight value to something other than 1.

After proper weighting has been assigned to each rule, the implication method is
implemented. A consequent is a fuzzy set represented by a membership function, which
weights appropriately the linguistic characteristics that are attributed to it. The
consequent is reshaped using a function associated with the antecedent (a single
number). The input for the implication process is a single number given by the
antecedent, and the output is a fuzzy set. Implication is implemented for each rule. Two
built-in methods are supported, and they are the same functions that are used by the AND
method: min (minimum), which truncates the output fuzzy set, and prod (product), which
scales the output fuzzy set.

Antecedent Consequent
A /\
r N '\
1. Fuzzify 2. Apply 3. Apply
. OR . Implication
inputs. operator (max) o i)
exoelent
o ] s A
If  service is excellent or food is delicious then fip = generous result of
implication
service =3 food = 8
input 1 input 2

Note Sugeno systems always use the product implication method.

Aggregate All Outputs

Since decisions are based on testing all the rules in a FIS, the rule outputs must be
combined in some manner. Aggregation is the process by which the fuzzy sets that
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represent the outputs of each rule are combined into a single fuzzy set. Aggregation only
occurs once for each output variable, which is before the final defuzzification step. The
input of the aggregation process is the list of truncated output functions returned by the
implication process for each rule. The output of the aggregation process is one fuzzy set
for each output variable.

As long as the aggregation method is commutative, then the order in which the rules are
executed is unimportant. Three built-in methods are supported:

* max (maximum)

* probor (probabilistic OR)

* sum (sum of the rule output sets)

In the following diagram, all three rules are displayed to show how the rule outputs are

aggregated into a single fuzzy set whose membership function assigns a weighting for
every output (tip) value.



Fuzzy Inference Process

2. Appl) 3. Apply
1. Fuzzify inputs. fuzz/;p v implication
operation method (min).
(OR = max)|
-
l [ ] poor rancid cheap
] 30% 0 30%
| If service is poor or food is rancid then tip = cheap |
- average,
2 L rule 2 has
no dependency
good on input 2
0 30 0 30%
| If service is good then tip = average |
excellent
3 ® delicious generous /-\
Q 30% 0 30% 4. Apply
A K . —_ aggregation
| If service is excellent or food is delicious then tip = generous method (max).
service =3 food =8
input 1 input 2
30%
Result of
aggregation

Note Sugeno systems always use the sum aggregation method.

Defuzzify

The input for the defuzzification process is a fuzzy set (the aggregate output fuzzy set)
and the output is a single number. As much as fuzziness helps the rule evaluation during
the intermediate steps, the final desired output for each variable is generally a single
number. However, the aggregate of a fuzzy set encompasses a range of output values, and
so must be defuzzified to obtain a single output value from the set.

There are five built-in defuzzification methods supported: centroid, bisector, middle of
maximum (the average of the maximum value of the output set), largest of maximum, and
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smallest of maximum. Perhaps the most popular defuzzification method is the centroid
calculation, which returns the center of area under the curve, as shown in the following:

5. Defuzzify the

aggregate output

0 309% (centroid).

tip = 16.7%

Result of

defuzzification

While the aggregate output fuzzy set covers a range from 0% though 30%, the defuzzified
value is between 5% and 25%. These limits correspond to the centroids of the cheap and
generous membership functions, respectively.

Fuzzy Inference Diagram

The fuzzy inference diagram is the composite of all the smaller diagrams presented so far
in this section. It simultaneously displays all parts of the fuzzy inference process you have
examined. Information flows through the fuzzy inference diagram as shown in the
following figure.
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ﬁ

Interpreting the
fuzzy inference
diagram

input 1 input 2

output

In this figure, the flow proceeds up from the inputs in the lower left, across each row, and
then down the rule outputs in the lower right. This compact flow shows everything at
once, from linguistic variable fuzzification all the way through defuzzification of the
aggregate output.

The following figure shows the actual full-size fuzzy inference diagram. Using a fuzzy
inference diagram, you can learn a lot about how the system operates. For instance, for
the particular inputs in this diagram, you can see that the implication method is
truncation with the min function. The max function is used for the fuzzy OR operation.
Rule 3 (the bottom-most row in the diagram shown previously) has the strongest influence
on the output. The Rule Viewer described in “The Rule Viewer” on page 2-33 is an
implementation of the fuzzy inference diagram.

1-35



1 Getting Started

2. Apply
o fuzzy 3. Apply
1. Fuzzify inputs. operation implication
(OR = max). method (min).
1 . poor rancid cheap
0 10 10 0% 30% 0% 30%
‘ If service is poor or food is rancid then tip = cheap ‘
average,
2 L] rule 2 has
no dependency
good on input 2
0 10 0% 30% 0% 30%
| If service is good then tip = average
excellent
3 - o generous
delicious
0 10 10 0% 30% 0% 30% 4. Apply
| If  service is excellent or food is delicious then tip = generous aggregation
method (max).
service =3 food =8
input 1 input 2 &)
5. Defuzzify
o o, (centroid).
tip = 16.7% 0% 30%
output

See Also

More About

. “Foundations of Fuzzy Logic” on page 1-10
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Membership Function Gallery

This example shows how to display 11 membership functions supported in the Fuzzy
Logic Toolbox4p.

Define membership functions.

mf =[...
fismf('trapmf',[-19 -17 -12 -71)
fismf('gbellmf',[3 4 -81])
fismf('trimf',[-9 -1 2])
fismf('gaussmf',[3 5]) ...
fismf('gauss2mf',[3 10 5 13])
fismf('smf',[11 17])
fismf('zmf',[-18 -10])
fismf('psigmf',[2 -11 -5 -4])
fismf('dsigmf',[5 -3 1 5])
fismf('pimf',[0 7 11 15])
fismf('sigmf',[2 15])

1;

For more information on the different membership functions and their parameters, see
their respective function reference pages.

Evaluate the membership functions.

X
y

linspace(-20,20,201);
evalmf(mf,x);

Plot the evaluated membership functions with labels.

subplot(2,1,1);
plot(x,y(1:6,:)"');
axis([min(x) max(x) 0 1.21);
text((mf(1l).Parameters(2)+mf(1l).Parameters(3))/2,1.1,mf(1).Type,...
"horizon', 'center');
text(mf(2).Parameters(3),1.1,mf(2).Type, ...
"horizon', 'center');
text(mf(3).Parameters(2),1.1,mf(3).Type, ...
"horizon', 'center');
text(mf(4).Parameters(2),1.1,mf(4).Type, ...
"horizon', 'center');
text ((mf(5).Parameters(2)+mf(5).Parameters(4))/2,1.1,mf(5).Type, ...
"horizon', 'center');
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text(mf(6).Parameters(2), 1.1,mf(6).Type,...
"horizon', 'center');

h gca = gca;

h gca.XTick = [];

subplot(2,1,2);

plot(x,y(7:11,:)"');

axis([min(x) max(x) 0 1.21);

text(mf(7).Parameters(1l),1.1,mf(7).Type, ...
"horizon', 'center');

text ((mf(8).Parameters(2)+mf(8).Parameters(4))/2,1.1,mf(8).Type, ...
"horizon', 'center');

text ((mf(9).Parameters(2)+mf(9).Parameters(4))/2,1.1,mf(9).Type, ...
"horizon', 'center');

text((mf(10).Parameters(2)+mf(10).Parameters(3))/2,1.1,mf(10).Type, ...

"horizon', 'center');
text(mf(1ll).Parameters(2),1.1,mf(11).Type,...
"horizon', 'center');
h gca = gca;
h gca.XTick = [];
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See Also

More About
. “Foundations of Fuzzy Logic” on page 1-10
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Defuzzification Methods

This example shows how to display five defuzzification methods supported in the Fuzzy
Logic Toolbox™.

Problem Setup

Suppose you have the following region to be defuzzified. What are some of the methods
you might choose?

X = -10:0.1:10;

mfl = trapmf(x,[-10 -8 -2 2]);

mf2 = trapmf(x,[-5 -3 2 4]);

mf3 = trapmf(x,[2 3 8 9]);

mfl = max(0.5*mf2,max(0.9*mfl,0.1*mf3));

figure('Tag', 'defuzz');
plot(x,mfl, 'LineWidth"',3);
h gca = gca;

h gca.YTick = [0 .5 1] ;
ylim([-1 11);
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Defuzzification Methods

0 N

Centroid

Centroid defuzzification returns the center of area under the curve. If you think of the
area as a plate of equal density, the centroid is the point along the x axis about which this
shape would balance.

x1 = defuzz(x,mfl, 'centroid'); % #ok<*NOPTS>
hl = line([x1 x11,[-0.2 1.2]1,'Color','k"');
tl = text(x1,-0.2,' centroid', 'FontWeight', 'bold");
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0 N

centroid

Bisector

The bisector is the vertical line that will divide the region into two sub-regions of equal
area. It is sometimes, but not always coincident with the centroid line.

x2 = defuzz(x,mfl, 'bisector');

gray = 0.7*[1 1 1];

hl.Color = gray;

tl.Color = gray;

h2 = line([x2 x2]1,[-0.4 1.2]1,'Color','k"');

t2 = text(x2,-0.4,' bisector', 'FontWeight', 'bold");

1-42



Defuzzification Methods

bisector

Middle, Smallest, and Largest of Maximum

MOM, SOM, and LOM stand for Middle, Smallest, and Largest of Maximum, respectively.
These three methods key off the maximum value assumed by the aggregate membership
function. In this example, because there is a plateau at the maximum value, they are
distinct. If the aggregate membership function has a unique maximum, then MOM, SOM,
and LOM all take on the same value.

X3 defuzz(x,mfl, 'mom")
x3 = -5
x4 = defuzz(x,mfl, 'som')

x4 = -2
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x5 = defuzz(x,mfl, 'lom')

x5 = -8

h2.Color = gray;

t2.Color = gray;

h3 = line([x3 x31,[-0.7 1.2]1,'Color','k"');

t3 = text(x3,-0.7,"' MOM', 'FontWeight', 'bold");

h4 = line([x4 x4]1,[-0.8 1.2],'Color','k"');

t4 = text(x4,-0.8,"' SOM', 'FontWeight', 'bold");

h5 = line([x5 x51,[-0.6 1.2]1, ' 'Color','k"');

t5 = text(x5,-0.6,"' LOM', 'FontWeight', 'bold");

'1 T T T T T
&1

DJ

LOM
MOM
SOM
-10 -8 -6 -4 -2 1] 2 4
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Picking a Method

Which of these methods is the right one? There's no simple answer. But if you want to get
started quickly, generally the centroid method is good enough. Later you can always
change your defuzzification method to see if another method works better.

h3.
t3.
ha.
t4.
h5.
t5.
hl.
tl.

Color
Color
Color
Color
Color
Color
Color
Color

gray;
gray;
gray;
gray;
gray;
gray;
'red';
'red';
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1 T T T T T T T
0.5 7
04 \—
centroid
=10 -8 -6 -4 -2 0 2 4 6 8 10
See Also
More About
. “Foundations of Fuzzy Logic” on page 1-10
. “Fuzzy Inference Process” on page 1-28
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Fuzzy vs. Nonfuzzy Logic

Basic Tipping Problem

To illustrate the value of fuzzy logic, examine both linear and fuzzy approaches to the
following problem:

What is the right amount to tip your waitperson?

First, work through this problem the conventional (nonfuzzy) way, writing MATLAB®
commands that spell out linear and piecewise-linear relations. Then, look at the same
system using fuzzy logic.

Basic Tipping Problem. Given a number from 0 through 10 that represents the quality
of service at a restaurant (where 10 is excellent), what should the tip be?

This problem is based on tipping as it is typically practiced in the United States. An
average tip for a meal in the US is 15%, though the actual amount can vary depending on
the quality of the service provided.

Nonfuzzy Approach

Begin with the simplest possible relationship. Suppose that the tip always equals 15% of
the total bill.

service = 0:.5:10;

tip = 0.15*ones(size(service));
plot(service,tip)
xlabel('Service')

ylabel('Tip"')

ylim([0.05 0.25])
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Service

This relationship does not account for the quality of the service, so you must add a term
to the equation. Since service is rated on a scale from 0 through 10, you the tip increase
linearly from 5% if the service is bad to 25% if the service is excellent. Now the relation
looks like the following plot:

tip = (.20/10)*service+0.05;
plot(service,tip)
xlabel('Service"')
ylabel('Tip")

ylim([0.05 0.25])
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=

0.25

0.2

0.15

0.1

0.05

Service

10

The formula does what you want it to do, and is straight forward. However, you may want
the tip to reflect the quality of the food as well. This extension of the problem is defined

as follows.

Extended Tipping Problem. Given two sets of numbers from 0 through 10 (where 10 is
excellent) that respectively represent the quality of the service and the quality of the food
at a restaurant, what should the tip be?

See how the formula is affected now that you have added another variable.

food = 0:.5:10;

meshgrid(food, service);
0.20/20) .*(S+F)+0.05;
surf(S,F,tip)

tip

1-49



1 Getting Started

xlabel('Service')
ylabel('Food")
zlabel('Tip"')

0.25 ~

0.2

2015

0.1

4

Food 0 o Service

In this case, the results look satisfactory, but when you look at them closely, they do not
seem right. Suppose that you want the service to be a more important factor than the
food quality. Specify that service accounts for 80% of the overall tipping grade and the
food makes up the other 20%.

servRatio = 0.8;

tip = servRatio*(0.20/10*%S+0.05) + ...
(1-servRatio)*(0.20/10*F+0.05);

surf(S,F,tip)

xlabel('Service')
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ylabel('Food")
zlabel('Tip"')

4

Food 0 o0

Service

The response is still some how too uniformly linear. Suppose that you want more of a flat
response in the middle, that is, you want to give a 15% tip in general, but want to also
specify a variation if the service is exceptionally good or bad. This factor, in turn, means
that the previous linear mappings no longer apply. You can still use the linear calculation
with a piecewise linear construction. Now, return to the one-dimensional problem of just
considering the service. You can create a simple conditional tip assignment using logical
indexing.

tip = zeros(size(service));

tip(service<3) = (0.10/3)*service(service<3)+0.05;
tip(service>=3 & service<7) = 0.15;
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tip(service>=7 & service<=10) = ...
(0.10/3)*(service(service>=7 & service<=10)-7)+0.15;

plot(service, tip)

xlabel('Service')

ylabel('Tip")

ylim([0.05 0.25])
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Service

Suppose that you extend this approach to two dimensions, where you account for food
quality again.

servRatio = 0.8;

tip = zeros(size(S));

tip(S<3) = ((0.10/3)*S(S<3)+0.05)*servRatio + ...
(1-servRatio)*(0.20/10*F(S<3)+0.05);
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tip(S>=3 & S<7) = (0.15)*servRatio + ...
(1-servRatio)*(0.20/10*F(S>=3 & S<7)+0.05);

tip(S>=7 & S<=10) = ((0.10/3)*(S(S>=7 & S<=10)-7)+0.15)*servRatio + ...
(1-servRatio)*(0.20/10*F(S>=7 & S<=10)+0.05);

surf(S,F,tip)

xlabel('Service')

ylabel('Food")

zlabel('Tip"')

4

Food 0 0 Service

The plot looks good, but the function is surprisingly complicated. It is even not apparent
how the algorithm works to someone who did not see the original design process.
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Fuzzy Logic Approach

In general, you want to capture the essentials of this problem, leaving aside all the factors
that could be arbitrary. If you make a list of what really matters in this problem, you could
end up with the following rule descriptions.

Tipping Problem Rules - Service Factor

» If service is poor, then tip is cheap
» If service is good, then tip is average
» If service is excellent, then tip is generous

The order in which the rules are presented here is arbitrary. It does not matter which
rules come first. To include the effect of food quality on the tip, add the following two
rules.

Tipping Problem Rules - Food Factor

» If food is rancid, then tip is cheap
» If food is delicious, then tip is generous

You can combine the two different lists of rules into one list of three rules like so.

Tipping Problem Rules - Both Service and Food Factors

» If service is poor or the food is rancid, then tip is cheap

» If service is good, then tip is average

+ If service is excellent or food is delicious, then tip is generous

These three rules are the core of your solution and they correspond to the rules for a
fuzzy logic system. When you give mathematical meaning to the linguistic variables (what
is an average tip, for example) you have a complete fuzzy inference system. The
methodology of fuzzy logic must also consider:

* How are the rules all combined?

* How do I define mathematically what an average tip is?

Problem Solution

The following plot represents the fuzzy logic system that solves the tipping problem.



Fuzzy vs. Nonfuzzy Logic

gensurf(readfis('tipper'))

4

food 0 o service

This plot was generated by the three rules that accounted for both service and food
factors.

Observations Consider some observations about the example so far. You found a
piecewise linear relation that solved the problem. It worked, but it was problematic to
derive, and when you wrote it down as code, it was not easy to interpret. Conversely, the
fuzzy logic system is based on some common sense statements. Also, you were able to add
two more rules to the list that influenced the shape of the overall output without needing
to undo what had already been done.

Moreover, by using fuzzy logic rules, the maintenance of the structure of the algorithm
decouples along fairly clean lines. The notion of an average tip can change from day to
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day, city to city, country to country. However, the underlying logic is the same: if the
service is good, the tip should be average.

Recalibrating the Method You can recalibrate the method quickly by simply shifting the
fuzzy set that defines average without rewriting the fuzzy logic rules.

You can shift lists of piecewise linear functions, but there is a greater likelihood for
difficult recalibration.

In the following example, the piecewise linear tipping problem is rewritten to make it
more generic. It performs the same function as before, only now the constants can be
easily changed.

lowTip = 0.05;
averTip = 0.15;
highTip = 0.25;
tipRange = highTip-lowTip;
badService = 0

okayService = 3;

goodService = 7;

greatService = 10;

serviceRange = greatService-badService;
badFood = 0;

greatFood = 10;
foodRange = greatFood-badFood;

% If service is poor or food is rancid, tip is cheap
if service<okayService
tip = (((averTip-lowTip)/(okayService-badService))
*service+lowTip)*servRatio + ...
(1-servRatio)*(tipRange/foodRange*food+lowTip);

% If service is good, tip is average
elseif service<goodService
tip = averTip*servRatio + (1l-servRatio)* ...
(tipRange/foodRange*food+lowTip);

% If service is excellent or food is delicious, tip is generous
else
tip = (((highTip-averTip)/ ...
(greatService-goodService))* ...
(service-goodService)+averTip)*servRatio + ...
(1-servRatio)*(tipRange/foodRange*food+lowTip);
end

1-56



See Also

As with all code, the more generality that is introduced, the less precise the algorithm
becomes. You can improve clarity by adding more comments, or perhaps rewriting the
algorithm in slightly more self-evident ways. But, the piecewise linear methodology is not
the optimal way to resolve this issue.

If you remove everything from the algorithm except for three comments, what remain are
exactly the fuzzy logic rules you previously wrote down.

» If service is poor or food is rancid, tip is cheap

» If service is good, tip is average

» If service is excellent or food is delicious, tip is generous

Fuzzy logic uses language that is clear to you and that also has meaning to the computer,
which is why it is a successful technique for bridging the gap between people and
machines.

By making the equations as simple as possible (linear) you make things simpler for the
machine, but more complicated for you. However, the limitation is no longer the computer
- it is your mental model of what the computer is doing. Fuzzy logic lets the machine work
with your preferences rather than the other way around.

See Also
Related Examples

. “Build Fuzzy Systems at the Command Line” on page 2-38
. “Build Fuzzy Systems Using Fuzzy Logic Designer” on page 2-14
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Types of Fuzzy Inference Systems

2-2

You can implement two types of fuzzy inference systems in the toolbox:

¢ Mamdani

* Sugeno
These two types of inference systems vary somewhat in the way outputs are determined.

Mamdani's fuzzy inference method is the most commonly seen fuzzy methodology.
Mamdani's method was among the first control systems built using fuzzy set theory. It was
proposed in 1975 by Ebrahim Mamdani [1] as an attempt to control a steam engine and
boiler combination by synthesizing a set of linguistic control rules obtained from
experienced human operators. Mamdani's effort was based on Lotfi Zadeh's 1973 paper
on fuzzy algorithms for complex systems and decision processes [2]. Although the
inference process described in the next few sections differs somewhat from the methods
described in the original paper, the basic idea is much the same.

Mamdani-type inference, as defined for the toolbox, expects the output membership
functions to be fuzzy sets. After the aggregation process, there is a fuzzy set for each
output variable that needs defuzzification. It is possible, and in many cases much more
efficient, to use a single spike as the output membership function rather than a
distributed fuzzy set. This type of output is sometimes known as a singleton output
membership function, and it can be thought of as a pre-defuzzified fuzzy set. It enhances
the efficiency of the defuzzification process because it greatly simplifies the computation
required by the more general Mamdani method, which finds the centroid of a two-
dimensional function. Rather than integrating across the two-dimensional function to find
the centroid, you use the weighted average of a few data points. Sugeno-type systems
support this type of model. In general, Sugeno-type systems can be used to model any
inference system in which the output membership functions are either linear or constant.

For descriptions of these two types of fuzzy inference systems, see [3], [1], and [4].

Fuzzy inference systems have been successfully applied in fields such as automatic
control, data classification, decision analysis, expert systems, and computer vision.
Because of its multidisciplinary nature, fuzzy inference systems are associated with a
number of names, such as fuzzy-rule-based systems, fuzzy expert systems, fuzzy
modeling, fuzzy associative memory, fuzzy logic controllers, and simply (and ambiguously)
fuzzy systems.



See Also
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What Is Mamdani-Type Fuzzy Inference?

2-4

Mamdani fuzzy inference is the most commonly seen fuzzy methodology and was among
the first control systems built using fuzzy set theory. It was proposed in 1975 by Ebrahim
Mamdani [1] as an attempt to control a steam engine and boiler combination by
synthesizing a set of linguistic control rules obtained from experienced human operators.
Mamdani's effort was based on Lotfi Zadeh's 1973 paper on fuzzy algorithms for complex
systems and decision processes [2]. Although the inference process described in the next
few sections differs somewhat from the methods described in the original paper, the basic
idea is much the same.

Mamdani-type inference, as defined for the toolbox, expects the output membership
functions to be fuzzy sets. After the aggregation process, there is a fuzzy set for each
output variable that needs defuzzification.
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What Is Sugeno-Type Fuzzy Inference?

This topic discusses the Sugeno, or Takagi-Sugeno-Kang, method of fuzzy inference.
Introduced in 1985 [1], this method is similar to the Mamdani method in many respects.
The first two parts of the fuzzy inference process, fuzzifying the inputs and applying the
fuzzy operator, are the same. The main difference between Mamdani and Sugeno is that
the Sugeno output membership functions are either linear or constant.

A typical rule in a Sugeno fuzzy model has the form:
If Input 1 is x and Input 2 is y, then Outputisz =ax + by + ¢

For a zero-order Sugeno model, the output level z is a constant (a = b = 0).

Each rule weights its output level, z;, by the firing strength of the rule, w;. For example,
for an AND rule with Input 1 = x and Input 2 = y, the firing strength is

w; = AndMethod(F1(x), Fy(y))
where F ,(.) are the membership functions for Inputs 1 and 2.

The final output of the system is the weighted average of all rule outputs, computed as

N
E Wiz
i=1
N
PR

i=1

Final Output =

where N is the number of rules.

A Sugeno rule operates as shown in the following diagram.
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2. Apply 3. Apply

1. Fuzzify inputs fuzzy implication
operation method (prod).
(OR = max)
-
l [ ] poor rancid
-
Z, (cheap) 2
| If service is poor or food is rancid then tip = cheap
-
2.
no dependency
good on input 2
- Z,(average) Z
| If service is good then tip = average
excellent
3 ® delicious
Z;(generous) Zs
| If service is excellent or food is delicious  then tip = generous
service = 3 food = 8
input 1 input 2 output
tip = 16.3%

Note Sugeno systems always use product implication and sum aggregation.

The preceding figure shows the fuzzy tipping model developed in “Fuzzy Inference
Process” on page 1-28 adapted for use as a Sugeno system. Fortunately, it is frequently
the case that singleton output functions are sufficient for the needs of a given problem. As
an example, the system tippersg. fis is the Sugeno-type representation of the now-
familiar tipping model. If you load the system and plot its output surface, you see that it is
almost the same as the Mamdani system you have previously seen.

fis = readfis('tippersg');
gensurf(fis)

2-6



What Is Sugeno-Type Fuzzy Inference?

4

food 0 o service

The easiest way to visualize first-order Sugeno systems is to think of each rule as defining
the location of a moving singleton. That is, the singleton output spikes can move around
in a linear fashion in the output space, depending on what the input is. This also tends to
make the system notation compact and efficient. Higher-order Sugeno fuzzy models are
possible, but they introduce significant complexity with little obvious merit. Sugeno fuzzy
models whose output membership functions are greater than first order are not
supported by Fuzzy Logic Toolbox software.

Because of the linear dependence of each rule on the input variables, the Sugeno method
is ideal for acting as an interpolating supervisor of multiple linear controllers that are to
be applied, respectively, to different operating conditions of a dynamic nonlinear system.
For example, the performance of an aircraft may change dramatically with altitude and
Mach number. Linear controllers, though easy to compute and suited to any given flight
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2-8

condition, must be updated regularly and smoothly to keep up with the changing state of
the flight vehicle. A Sugeno fuzzy inference system is suited to the task of smoothly
interpolating the linear gains that would be applied across the input space; it is a natural
and efficient gain scheduler. Similarly, a Sugeno system is suited for modeling nonlinear
systems by interpolating between multiple linear models.

To see a specific example of a system with linear output membership functions, consider
the one-input, one-output system stored in sugenol. fis. Load the system and view the
properties of its output variable.

fis = readfis('sugenol');
fis.Outputs(1l)

ans =
fisvar with properties:

Name: "output"”
Range: [0 1]
MembershipFunctions: [1x2 fismf]

The output variable has two membership functions. View the properties of the first
membership function.

fis.OQutputs(1l).MembershipFunctions(1)

ans =
fismf with properties:

Name: "linel"
Type: "linear"
Parameters: [-1 -1]

View the properties of the second membership function.
fis.Outputs(1l).MembershipFunctions(2)

ans =
fismf with properties:

Name: "line2"
Type: "linear"
Parameters: [1 -1]



What Is Sugeno-Type Fuzzy Inference?

Further, these membership functions are linear functions of the input variable. The
membership function 1inel is defined by the equation:

output = (- 1) X input + (- 1)
and the membership function 1ine2 is:
output = (1) X input + (- 1)

The input membership functions and rules define which of these output functions are
expressed and when:

fis.Rules

ans =
1x2 fisrule array with properties:

Description
Antecedent
Consequent
Weight
Connection

Details:
Description

1 "input==low => output=linel (1)"
2 "input==high => output=line2 (1)"

The function plotmf shows us that the membership function low generally refers to
input values less than zero, while high refers to values greater than zero. The function
gensurf shows how the overall fuzzy system output switches smoothly from the line
called linel to the line called line2.

subplot(2,1,1)
plotmf(fis, "input',1)
subplot(2,1,2)
gensurf(fis)
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As this example shows, Sugeno-type system gives you the freedom to incorporate linear
systems into your fuzzy systems. By extension, you could build a fuzzy system that
switches between several optimal linear controllers as a highly nonlinear system moves
around in its operating space.

References

[1] Sugeno, M., Industrial applications of fuzzy control, Elsevier Science Pub. Co., 1985.

See Also

gensurf | readfis
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More About

. “Comparison of Sugeno and Mamdani Systems” on page 2-12
. “What Is Mamdani-Type Fuzzy Inference?” on page 2-4
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Comparison of Sugeno and Mamdani Systems

2-12

Because it is a more compact and computationally efficient representation than a
Mamdani system, a Sugeno system lends itself to the use of adaptive techniques for
constructing fuzzy models. These adaptive techniques can be used to customize the
membership functions so that the fuzzy system best models the data.

You can convert a Mamdani system into a Sugeno system using the convertToSugeno
function. The resulting Sugeno system has constant output membership functions that
correspond to the centroids of the Mamdani output membership functions.

Advantages of the Sugeno Systems

Sugeno systems:

* Are computationally efficient.

*  Work well with linear techniques, such as PID control.
»  Work well with optimization and adaptive techniques.
* Guarantee continuity of the output surface.

* Well-suited to mathematical analysis.

Advantages of the Mamdani Systems

Mamdani systems:

* Are intuitive.
* Have widespread acceptance.
* Are well-suited to human input.

See Also

convertToSugeno

More About
. “What Is Mamdani-Type Fuzzy Inference?” on page 2-4



See Also

“What Is Sugeno-Type Fuzzy Inference?” on page 2-5
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Build Fuzzy Systems Using Fuzzy Logic Designer

Fuzzy Logic Toolbox Graphical User Interface Tools

This example shows how to build a fuzzy inference system (FIS) for the tipping example,
described in “The Basic Tipping Problem” on page 2-16, using the Fuzzy Logic Toolbox
UI tools.

You use the following tools to build, edit, and view fuzzy inference systems:

* Fuzzy Logic Designer to handle the high-level issues for the system — How many
input and output variables? What are their names?

Fuzzy Logic Toolbox software does not limit the number of inputs. However, the
number of inputs may be limited by the available memory of your machine. If the
number of inputs is too large, or the number of membership functions is too big, then
it may also be difficult to analyze the FIS using the other tools.

* Membership Function Editor on page 2-22 to define the shapes of all the
membership functions associated with each variable

* Rule Editor on page 2-30 to edit the list of rules that defines the behavior of the
system.

* Rule Viewer on page 2-33 to view the fuzzy inference diagram. Use this viewer as a
diagnostic to see, for example, which rules are active, or how individual membership
function shapes influence the results

» Surface Viewer on page 2-35 to view the dependency of one of the outputs on any
one or two of the inputs; that is, it generates and plots an output surface map for the
system.

These Uls are dynamically linked, in that changes you make to the FIS using one of them,
affect what you see on any of the other open Uls. For example, if you change the names of
the membership functions in the Membership Function Editor, the changes are reflected
in the rules shown in the Rule Editor. You can use the Uls to read and write variables both
to the MATLAB workspace and to a file (the read-only viewers can still exchange plots
with the workspace and save them to a file). You can have any or all of them open for any
given system or have multiple editors open for any number of fuzzy systems.
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Rule Editor

Fuzzy Logic Designer
e
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The following figure shows how the main components of a FIS and the three editors fit
together. The two viewers examine the behavior of the entire system.

The General Case...

A Specific Example...

The GUI Editors...

Input === Output

¥

Rules
Input Output
terms terms
(interpret) (assign)

service m==gp- tip

¥

if service is poor then tip is cheap
if service is good then tip is average
if service is excellent then tip is generous

Y N

service = tip =

{poor, {cheap,
good, average,
excellent} generous}

The FIS Editor

4

The Rule Editor

Y N

The Membership
Function Editor




2 Fuzzy Inference System Modeling

2-16

In addition to these five primary Uls, the toolbox includes the graphical Neuro-Fuzzy
Designer, which you use to build and analyze Sugeno-type adaptive neuro-fuzzy
inference systems.

The Fuzzy Logic Toolbox Uls do not support building a FIS using data. If you want to use
data to build a FIS, use one of the following techniques:

* genfis to generate a Sugeno-type FIS. Then, select File > Import in the Fuzzy
Logic Designer to import the FIS and perform fuzzy inference, as described in “The
Fuzzy Logic Designer” on page 2-17.

* Neuro-adaptive learning techniques to model the FIS, as described in “Neuro-Adaptive
Learning and ANFIS” on page 3-86.

If you want to use MATLAB workspace variables, use the command-line interface instead
of the Fuzzy Logic Designer. For an example, see “Build Fuzzy Systems at the Command
Line” on page 2-38.

The Basic Tipping Problem

This example creates a Mamdani fuzzy inference system using on a two-input, one-output
tipping problem based on tipping practices in the U.S. While the example creates a
Mamdani FIS, the methods used apply to creating Sugeno systems as well.

Given a number between 0 and 10 that represents the quality of service at a restaurant
(where 10 is excellent), and another number between 0 and 10 that represents the quality
of the food at that restaurant (again, 10 is excellent), what should the tip be?

The starting point is to write down the three golden rules of tipping:

1 [fthe service is poor or the food is rancid, then tip is cheap.
2 Ifthe service is good, then tip is average.
3 Ifthe service is excellent or the food is delicious, then tip is generous.

Assume that an average tip is 15%, a generous tip is 25%, and a cheap tip is 5%.
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25 —

15 —

Bud service or bud food Grent service or greaf food

The numbers and the shape of the curve are subject to local traditions, cultural bias, and
so on, but the three rules are generally universal.

Now that you know the rules and have an idea of what the output should look like, use the

UI tools to construct a fuzzy inference system for this decision process.

The Fuzzy Logic Designer

The Fuzzy Logic Designer displays information about a fuzzy inference system. To open
the Fuzzy Logic Designer, type the following command at the MATLAB prompt:

fuzzylLogicDesigner

The Fuzzy Logic Designer opens and displays a diagram of the fuzzy inference system
with the names of each input variable on the left, and those of each output variable on the
right, as shown in the next figure. The sample membership functions shown in the boxes
are just icons and do not depict the actual shapes of the membership functions.

2-17



2 Fuzzy Inference System Modeling

Double-click the input variable icon to
open the Membership Function Editor

) Fuzzy Logic Designer: Untitled oy ] 24|
File Edit View
Untitled
(mamdani)
input1 output1
[ Eﬂ; ramdani/)

|
Double-click the output variable icon to
open the Membership Function Editor

Double-click the system
diagram to open the Rule Editor

Below the diagram is the name of the system and the type of inference used.
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Name of the system.
To change it, select
File > Export > To Workspace.

FIS Name: Untitled FIS Type: mamdani
And method = = Current Variable
Or method | max - Bame | input! |
Implication = -1 || ™Pe hout

Range [01]
Aggregation I max v l
Defuzzification I centroid v I Help (flose

System "Untitled™: 1 input, 1 output, and 0 rules <-|

Options for adjusting the fuzzy Status line describes Name of the selected input
inference functions, such the most recent operation. or output variables.
as the defuzzification method.

In this example, you use the default Mamdani-type inference. Another type of inference,
called Sugeno-type inference, is also available. See “What Is Sugeno-Type Fuzzy
Inference?” on page 2-5.

In the Fuzzy Logic Designer:

* The drop-down lists let you modify the fuzzy inference functions.

* The Current Variable area displays the name of either an input or output variable, its
type, and default range.

» A status line at the bottom displays information about the most recent operation.

To build the fuzzy inference system described in “The Basic Tipping Problem” on page 2-
16 from scratch, type the following command at the MATLAB prompt:

fuzzylLogicDesigner

The generic untitled Fuzzy Logic Designer opens, with one input input1, and one
output outputl.
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i i

Fil= Edit View

Untitled

(ramdani)
input1 outputi
FIS Marme: Untitled FIS Type: rmarmcani
And method min - Current Yariakle
Or method T = Matne I—inpuﬂ
T input
Implication min - LS e
Rance [01]
Aggregation M -
Defuzzification I centroid - I Help Close
System "Untitled": 1 input, 1 output, and O rules

Tip To open the Fuzzy Logic Designer with the prebuilt fuzzy inference system stored
in tipper.fis, enter

fuzzylLogicDesigner('tipper.fis')

However, if you load the prebuilt system, you will not build rules or construct membership
functions.

In this example, you construct a two-input, one output system. The two inputs are service
and food. The one output is tip.

To add a second input variable and change the variable names to reflect these
designations:

1 Select Edit > Add variable > Input.
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0 N OO U1 A W N

A second yellow box labeled input2 appears.

Click the yellow box input1. This box is highlighted with a red outline.
Edit the Name field from inputl to service, and press Enter.

Click the yellow box input2. This box is highlighted with a red outline.
Edit the Name field from input2 to food, and press Enter.

Click the blue box outputl.

Edit the Name field from outputl to tip, and press Enter.

Select File > Export > To Workspace.

CEE ~lolx|

Save current FIS to workspace

Wiarkspace variable ILlnt'rtIed

Ok | Cancel

Enter the Workspace variable name tipper, and click OK.

The diagram is updated to reflect the new names of the input and output variables.
There is now a new variable in the workspace called tipper that contains all the
information about this system. By saving to the workspace with a new name, you also
rename the entire system. Your window looks something like the following diagram.
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2-22

i i

File Edit View

XX~

senvice tipper

(mamdani)

-
- -
e -
; ;-:_-'_‘\ ; tip
food

FIS Name: tipper FIS Type: mamdani
And method — = Current Variable
Or method max -] || Mame I

T
Implication — - bid

Range
Aggregation max -
Defuzzification I centroid - I Help Close
Updating Rule Editor

Leave the inference options in the lower left in their default positions for now. You have
entered all the information you need for this particular Ul. Next, define the membership
functions associated with each of the variables. To do this, open the Membership Function
Editor.

You can open the Membership Function Editor in one of three ways:

* Within the Fuzzy Logic Designer window, select Edit > Membership Functions.
* Within the Fuzzy Logic Designer window, double-click the blue icon called tip.
* At the command line, type mfedit.

The Membership Function Editor

The Membership Function Editor is the tool that lets you display and edit all of the
membership functions associated with all of the input and output variables for the entire
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fuzzy inference system. The Membership Function Editor shares some features with the
Fuzzy Logic Designer, as shown in the next figure. In fact, all of the five basic UI tools
have similar menu options, status lines, and Help and Close buttons.

Menu commands for "Variable Palette" area.
saving, opening, and editing Click a variable to edit its
a fuzzy system. membership functions.

) Membership Function/Editor: tipper

=10i x|
File Edit View
FIS Variables / Membership function plats  Plot points: 181
poor good exce‘llem
O [
0
service tip
05 i
food

Graph displays all
membership functions
for the selected variable.

Click a line to change its attributes,
such as name, type, and numerical parameters.
Drag the curve to move it or to change its shape.
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Set the display range
of the current plot.

__ Set the range Name and type of
of the current variable. current variable.
Current Yariable Current Membership Function (click on MF to select)

Name service Narne I good
Type input Type I gjussmf - [

Params
[155] /'
L Rahge I[U 10] I i :
Display Range 1010 Help | / Close |

v

Ready /

VA
7

This status line Change the numerical Select the type of Edit name of current
describes the most parameters for current current membership  membership function.
recent operation. membership function. function.

When you open the Membership Function Editor to work on a fuzzy inference system that
does not already exist in the workspace, there are no membership functions associated
with the variables that you defined with the Fuzzy Logic Designer.

On the upper-left side of the graph area in the Membership Function Editor is a "Variable
Palette" that lets you set the membership functions for a given variable.

To set up the membership functions associated with an input or an output variable for the
FIS, select a FIS variable in this region by clicking it.

Next select the Edit pull-down menu, and choose Add MFs .. A new window appears,
which allows you to select both the membership function type and the number of
membership functions associated with the selected variable. In the lower-right corner of
the window are the controls that let you change the name, type, and parameters (shape),
of the membership function, after it is selected.

The membership functions from the current variable are displayed in the main graph.
These membership functions can be manipulated in two ways. You can first use the mouse
to select a particular membership function associated with a given variable quality, (such
as poor, for the variable, service), and then drag the membership function from side to
side. This action affects the mathematical description of the quality associated with that
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membership function for a given variable. The selected membership function can also be
tagged for dilation or contraction by clicking on the small square drag points on the
membership function, and then dragging the function with the mouse toward the outside,
for dilation, or toward the inside, for contraction. This action changes the parameters
associated with that membership function.

Below the Variable Palette is some information about the type and name of the current
variable. There is a text field in this region that lets you change the limits of the current
variable's range (universe of discourse) and another that lets you set the limits of the
current plot (which has no real effect on the system).

The process of specifying the membership functions for the two-input tipping example,
tipper, is as follows:

1  Double-click the input variable service to open the Membership Function Editor.

-} Membership Function Editor: tipper 101 =l

Fil= Edit  View

FIS Variahles Membership function plots  PIct paints: 151
. mf1 I I I I rnlf2 I I I I mf3
1
(3] N
SEMVice tip

food

0 0.1 0.2 0.3 0.4 0 0.6 0.7 0.8 0.9

input variable "zervice”

Current Yariakle Current Membership Function (click on MF {0 select)

Matne

Matne Service mf1

Type input Tipe Itrimf - I

Params

Reange = {04004
Display Range I[D 1] Help | Close |

Ready
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In the Membership Function Editor, enter [0 10] in the Range and the Display
Range fields.

Create membership functions for the input variable service.

d

e

Select Edit > Remove All MFs to remove the default membership functions for
the input variable service.

Select Edit > Add MFs to open the Membership Functions dialog box.
In the Membership Functions dialog box, select gaussmf as the MF Type.

<) Membership Functions =10l x|

Add retmber ship functions

MF type

Mumber of kMFz I 5 d

O | Cancel |

Verify that 3 is selected as the Number of MFs.
Click OK to add three Gaussian curves to the input variable service.

Rename the membership functions for the input variable service, and specify their
parameters.

Click on the curve named mf1 to select it, and specify the following fields in the
Current Membership Function (click on MF to select) area:

* In the Name field, enter poor.
¢ Inthe Params field, enter [1.5 0O].

The two inputs of Params represent the standard deviation and center for the
Gaussian curve.

Tip To adjust the shape of the membership function, type in the desired
parameters or use the mouse, as described previously.

Click on the curve named mf2 to select it, and specify the following fields in the
Current Membership Function (click on MF to select) area:

* In the Name field, enter good.
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* In the Params field, enter [1.5 5].

Click on the curve named mf3, and specify the following fields in the Current
Membership Function (click on MF to select) area:

« In the Name field, enter excellent.
* In the Params field, enter [1.5 10].

The Membership Function Editor window looks similar to the following figure.

) Membership Function Editor: tipper = |EI|5|

File Edit View

FIS Variables Membership function plots  Plot points: 181
. poor good excellent

1

BC0 i

SEVICE tip
food h
o | | | | | N N N N 7
0 1 2 3 4 5 B P 10
input variable "service”
Current Yariable Current Membership Function (click on MF to select)

Mt setvice Mt I excellent
Type input Type I gaussmf - I

Paratns
1.510
Range I [10] I [ 1
Display Range I[D 10] Help | Cloze |

Changing parameter for MF 3to [1.510]

In the FIS Variables area, click the input variable food to select it.
Enter [0 10] in the Range and the Display Range fields.
Create the membership functions for the input variable food.

a Select Edit > Remove All MFs to remove the default Membership Functions for
the input variable food.
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b  Select Edit > Add MFs to open the Membership Functions dialog box.
¢ In the Membership Functions dialog box, select trapmf as the MF Type.
d Select 2 in the Number of MFs drop-down list.
e C(Click OK to add two trapezoidal curves to the input variable food.
8 Rename the membership functions for the input variable food, and specify their
parameters:
a In the FIS Variables area, click the input variable food to select it.
Click on the curve named mf1, and specify the following fields in the Current
Membership Function (click on MF to select) area:
* In the Name field, enter rancid.
e In the Params field, enter [0 @ 1 3].
¢ Click on the curve named mf2 to select it, and enter delicious in the Name
field.
Reset the associated parameters if desired.
9  Click on the output variable tip to select it.
10 Enter [0 30] in the Range and the Display Range fields to cover the output range.

The inputs ranges from 0 to 10, but the output is a tip between 5% and 25%.
11 Rename the default triangular membership functions for the output variable tip, and
specify their parameters.

a  Click the curve named mf1 to select it, and specify the following fields in the
Current Membership Function (click on MF to select) area:

* In the Name field, enter cheap.
¢ In the Params field, enter [0 5 10].

b  Click the curve named mf2 to select it, and specify the following fields in the
Current Membership Function (click on MF to select) area:

* In the Name field, enter average.
* In the Params field, enter [10 15 20].
¢ Click the curve named mf3 to select it, and specify the following:

* In the Name field, enter generous.
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* In the Params field, enter [20 25 30].

The Membership Function Editor looks similar to the following figure.

Now that the variables have been named and the membership functions have appropriate
shapes and names, you can enter the rules. To call up the Rule Editor, go to the Edit
menu and select Rules, or type ruleedit at the command line.

2-29



2 Fuzzy Inference System Modeling

The Rule Editor

The menu items allow The rules are
you to save, open, or entered

edit a fuzzy system . automatically
using any of the five Input or output selection menus. using the GUI

basic GUI tools.

/A tools.

|4' Rule Editor: tipper

File Edit View Options

poor] o eap
2. If [service is good) then [tip is ayérage) (1
3. If [service is excellent) or (food/s delicioys) then [tip is generous) [

[ -]
If or Then
SEIVICe | food i tip is
poo ancid p
good delicious average
excellent none generous
none none
= [

not

Delete rule | ule | Changerulel

Link input / = I =
statements irﬁ J FIS Name: tlp}\q I /\ /[ Help l Close, ||

N—T

N— Y

Negate input or output Create or edit rules with the GUI buttons and The Help button

statements in rules. choices from the input or output selection menus. ~ 9IVes some
information about
how the Rule Editor
works, and the
Close button closes
the window.

This status line
describes the most
recent operation.

Constructing rules using the graphical Rule Editor interface is fairly self evident. Based
on the descriptions of the input and output variables defined with the Fuzzy Logic
Designer, the Rule Editor allows you to construct the rule statements automatically. You
can:
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* Create rules by selecting an item in each input and output variable box, selecting one
Connection item, and clicking Add Rule. You can choose none as one of the variable
qualities to exclude that variable from a given rule and choose not under any variable
name to negate the associated quality.

* Delete a rule by selecting the rule and clicking Delete Rule.
» Edit a rule by changing the selection in the variable box and clicking Change Rule.

» Specify weight to a rule by typing in a desired number between 0 and 1 in Weight. If
you do not specify the weight, it is assumed to be unity (1).

Similar to those in the Fuzzy Logic Designer and the Membership Function Editor, the
Rule Editor has the menu bar and the status line. The menu items allow you to open,
close, save and edit a fuzzy system using the five basic UI tools. From the menu, you can
also:

* Set the format for the display by selecting Options > Format.
* Set the language by selecting Options > Language.

You can access information about the Rule Editor by clicking Help and close the UI using
Close.

To insert the first rule in the Rule Editor, select the following:

* poor under the variable service

* rancid under the variable food

* The or radio button, in the Connection block
» cheap, under the output variable, tip.

Then, click Add rule.

The resulting rule is
1. If (service is poor) or (food is rancid) then (tip is cheap) (1)

The numbers in the parentheses represent weights.
Follow a similar procedure to insert the second and third rules in the Rule Editor to get

1 If(service is poor) or (food is rancid) then (tip is cheap) (1)
2 If (service is good) then (tip is average) (1)
3 If(service is excellent) or (food is delicious) then (tip is generous) (1)
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Tip To change a rule, first click on the rule to be changed. Next make the desired
changes to that rule, and then click Change rule. For example, to change the first rule to
1. If (service not poor) or (food not rancid) then (tip is not cheap) (1)

Select the not check box under each variable, and then click Change rule.

The Format pop-up menu from the Options menu indicates that you are looking at the
verbose form of the rules. Try changing it to symbolic. You will see

1. (service==poor) | (food==rancid) => (tip=cheap) (1)

2. (service==good) => (tip=average) (1)

3. (service==excellent) | (food==delicious) => (tip=generous) (1)

There is not much difference in the display really, but it is slightly more language neutral,
because it does not depend on terms like if and then. If you change the format to indexed,
you see an extremely compressed version of the rules.

11,1(1):2

20,2(1):1

32,3(1):2

This is the version of the rules that the machine deals with.

* The first column in this structure corresponds to the input variables.
* The second column corresponds to the output variable.
* The third column displays the weight applied to each rule.

e The fourth column is shorthand that indicates whether this is an OR (2) rule or an
AND (1) rule.

* The numbers in the first two columns refer to the index number of the membership
function.

A literal interpretation of rule 1 is "If input 1 is MF1 (the first membership function
associated with input 1) or if input 2 is MF1, then output 1 should be MF1 (the first
membership function associated with output 1) with the weight 1."

The symbolic format does not consider the terms, if, then, and so on. The indexed format
doesn't even bother with the names of your variables. Obviously the functionality of your
system doesn't depend on how well you have named your variables and membership
functions. The whole point of naming variables descriptively is, as always, making the
system easier for you to interpret. Thus, unless you have some special purpose in mind, it
is probably be easier for you to continue with the verbose format.
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At this point, the fuzzy inference system has been completely defined, in that the
variables, membership functions, and the rules necessary to calculate tips are in place.
Now, look at the fuzzy inference diagram presented at the end of the previous section and
verify that everything is behaving the way you think it should. You can use the Rule
Viewer, the next of the UI tools we'll look at. From the View menu, select Rules.

The Rule Viewer

<} Rule Yiewer: tipper o ] 4

File Edit ‘iew Options

zervice =35 food = 5
1 \
? A

tip=15

A

Imput: 5 5] Plot points: Iim Move:  |of | right | dnwnl up |

Fule 2. If (service i= good) then (tip iz average) (1) Help | Close |

The Rule Viewer displays a roadmap of the whole fuzzy inference process. It is based on
the fuzzy inference diagram described in the previous section. You see a single figure
window with 10 plots nested in it. The three plots across the top of the figure represent
the antecedent and consequent of the first rule. Each rule is a row of plots, and each
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column is a variable. The rule numbers are displayed on the left of each row. You can click
on a rule number to view the rule in the status line.

The first two columns of plots (the six yellow plots) show the membership functions
referenced by the antecedent, or the if-part of each rule.

The third column of plots (the three blue plots) shows the membership functions
referenced by the consequent, or the then-part of each rule.

Notice that under food, there is a plot which is blank. This corresponds to the
characterization of none for the variable food in the second rule.

The fourth plot in the third column of plots represents the aggregate weighted
decision for the given inference system.

This decision will depend on the input values for the system. The defuzzified output is
displayed as a bold vertical line on this plot.

The variables and their current values are displayed on top of the columns. In the lower
left, there is a text field Input in which you can enter specific input values. For the two-
input system, you will enter an input vector, [9 8], for example, and then press Enter.
You can also adjust these input values by clicking on any of the three plots for each input.
This will move the red index line horizontally, to the point where you have clicked.
Alternatively, you can also click and drag this line in order to change the input values.
When you release the line, (or after manually specifying the input), a new calculation is
performed, and you can see the whole fuzzy inference process take place:

Where the index line representing service crosses the membership function line
"service is poor" in the upper-left plot determines the degree to which rule one is
activated.

A yellow patch of color under the actual membership function curve is used to make
the fuzzy membership value visually apparent.

Each of the characterizations of each of the variables is specified with respect to the input
index line in this manner. If you follow rule 1 across the top of the diagram, you can see
the consequent "tip is cheap" has been truncated to exactly the same degree as the
(composite) antecedent — this is the implication process in action. The aggregation
occurs down the third column, and the resultant aggregate plot is shown in the single plot
appearing in the lower right corner of the plot field. The defuzzified output value is shown
by the thick line passing through the aggregate fuzzy set.

You can shift the plots using left, right, down, and up. The menu items allow you to save,
open, or edit a fuzzy system using any of the five basic Ul tools.
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The Rule Viewer allows you to interpret the entire fuzzy inference process at once. The
Rule Viewer also shows how the shape of certain membership functions influences the
overall result. Because it plots every part of every rule, it can become unwieldy for
particularly large systems, but, for a relatively small number of inputs and outputs, it
performs well (depending on how much screen space you devote to it) with up to 30 rules
and as many as 6 or 7 variables.

The Rule Viewer shows one calculation at a time and in great detail. In this sense, it
presents a sort of micro view of the fuzzy inference system. If you want to see the entire
output surface of your system — the entire span of the output set based on the entire
span of the input set — you need to open up the Surface Viewer. This viewer is the last of
the five basic Fuzzy Logic Toolbox UI tools. To open the Surface Viewer, select Surface
from the View menu.

The Surface Viewer

) surface Viewer: tipper 101 =l
File Edit View Options

0]
food o service

A (inpt ) Iser\rice ,I N Cinput Iﬂmd ,I Z (output): tip -
X grids: |15 ¥ grids: |15 Evaluate |

Ref. Input: [ Plat poirts: Fm Help | Close |

Ready
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Upon opening the Surface Viewer, you see a three-dimensional curve that represents the
mapping from food and service quality to tip amount. Because this curve represents a
two-input one-output case, you can see the entire mapping in one plot. When we move
beyond three dimensions overall, we start to encounter trouble displaying the results.

Accordingly, the Surface Viewer is equipped with drop-down menus X (input), Y (input)
and Z (output) that let you select any two inputs and any one output for plotting. Below
these menus are two input fields X grids and Y grids that let you specify how many x-axis
and y-axis grid lines you want to include. This capability allows you to keep the
calculation time reasonable for complex problems.

By default, the surface plot updates automatically when you change the input or output
variable selections or the number of grid points. To disable automatic plot updates, in the
Options menu, clear the Always evaluate option. When this option is disabled, to update
the plot, click Evaluate.

If you want to create a smoother plot, use the Plot points field to specify the number of
points on which the membership functions are evaluated in the input or output range.
This field defaults to the minimum number of plot plots, 101. If you specify fewer plot
points, the field value automatically resets to 101. When you specify the number of plot
points, the surface plot automatically updates.

By clicking on the plot axes and dragging the mouse, you can manipulate the surface so
that you can view it from different angles.

The Ref. Input field is used in situations when there are more inputs required by the
system than the surface is mapping. You can edit this field to explicitly set inputs not
specified in the surface plot.

Suppose you have a four-input one-output system and would like to see the output
surface. The Surface Viewer can generate a three-dimensional output surface where any
two of the inputs vary, but two of the inputs must be held constant because computer
monitors cannot display a five-dimensional shape. In such a case, the input is a four-
dimensional vector with NaNs holding the place of the varying inputs while numerical
values indicates those values that remain fixed.

The menu items allow you to open, close, save and edit a fuzzy system using the five basic
UI tools. You can access information about the Surface Viewer by clicking Help and close
the UI using Close.



See Also

Importing and Exporting Fuzzy Inference Systems

When you save a fuzzy system to a file, you are saving an ASCII text FIS file
representation of that system with the file suffix . fis. Do not manually edit the contents
of a . fis file. Doing so can produce unexpected results when loading the file. When you
save your fuzzy system to the MATLAB workspace, you are creating a variable that acts as
a MATLAB object for the fuzzy system.

Note If you do not save your FIS to a file, but only save it to the MATLAB workspace, you
cannot recover it for use in a new MATLAB session.

See Also
Fuzzy Logic Designer

More About

. “What Is Mamdani-Type Fuzzy Inference?” on page 2-4
. “Build Fuzzy Systems at the Command Line” on page 2-38
. “Simulate Fuzzy Inference Systems in Simulink” on page 5-2
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Build Fuzzy Systems at the Command Line

You can construct a fuzzy inference system (FIS) at the MATLAB® command line. This
method is an alternative to interactively designing your FIS using Fuzzy Logic Designer.

This example shows you how to create a Mamdani fuzzy inference system. While you
create a Mamdani FIS, the methods used apply to creating Sugeno systems as well.

Tipping Problem at the Command Line

To demonstrate the command-line functionality for creating and viewing fuzzy inference
systems, this example uses the tipper FIS.

fis = readfis('tipper.fis');

This command returns a mamfis object that contains the properties of the fuzzy system.
For a Sugeno system, this command returns a sugfis object.

You can access the FIS properties using dot notation. For example, view the inputs of the
fuzzy system.

fis.Inputs

ans =

1x2 fisvar array with properties:

Name
Range
MembershipFunctions
Details:
Name Range MembershipFunctions
1 "service" 0 10 [1x3 fismf]
2 "food" 0 10 [1x2 fismf]

To set the properties of your fuzzy system, use dot notation. For example, set the name of
the FIS.

fis.Name = "gratuity";



Build Fuzzy Systems at the Command Line

FIS Object

You represent fuzzy inference systems using mamfis and sugfis objects. These objects
contain all the fuzzy inference system information, including the variable names,
membership function definitions, and fuzzy inference methods. Each FIS is itself a
hierarchy of objects. The following objects are used within a fuzzy system:

» fisvar objects represent both input and output variables.

» fismf objects represent membership functions within each input and output variable.
+ fisrule objects represent fuzzy rules that map inputs to outputs.

View all the information for a FIS by directly listing its properties.

fis

fis =
mamfis with properties:

Name: "gratuity"
AndMethod: "min"
OrMethod: "max"
ImplicationMethod: "min"
AggregationMethod: "max"
DefuzzificationMethod: "centroid"
Inputs: [1x2 fisvar]
Outputs: [1x1 fisvar]
Rules: [1x3 fisrule]
DisableStructuralChecks: 0

See 'getTunableSettings' method for parameter optimization.
You can view the properties of the objects within a FIS object using dot notation. For
example, view the fisvar object for first input variable.

fis.Inputs(1)

ans =

fisvar with properties:
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Name: "service"
Range: [0 10]
MembershipFunctions: [1x3 fismf]

Also, view the membership functions for this variable.

fis.Inputs(1l).MembershipFunctions

ans =

1x3 fismf array with properties:

Name
Type
Parameters
Details:

Name Type Parameters
1 "poor" "gaussmf" 1.5 0
2 "good" "gaussmf" 1.5 5
3 "excellent" "gaussmf" 1.5 10

System Display Functions

To get a high-level view of your fuzzy system from the command line, use the plotfis,
plotmf, and gensurf functions. plotfis displays the whole system as a block diagram,
as shown in the Fuzzy Logic Designer.

plotfis(fis)
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service (3 gratuity
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3 ules
tip (3)
food (2)

Systemn gratuity: 2 inputs, 1 cutputs, 3 rules

The plotmf function plots all the membership functions associated with a given variable.
For example, view the membership functions for the first input variable.

plotmf(fis, "input',1)
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Similarly, to view the membership functions for the first output, type:

plotmf(fis, 'output',1)
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plotmf does not support viewing the output membership functions for Sugeno systems.
To view the rules of the fuzzy system, type:
fis.Rules

ans =

1x3 fisrule array with properties:
Description
Antecedent

Consequent
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Weight
Connection
Details:
Description
1 "service==poor | food==rancid => tip=cheap (1)"
2 "service==good => tip=average (1)"
3 "service==excellent | food==delicious => tip=generous (1)"

The gensurf function plots the output of the FIS for any one or two input variables.

gensurf(fis)
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4

food 0 o0 service

Build Fuzzy Inference System

As an alternative to using the Fuzzy Logic Designer app, you can construct a FIS
entirely from the command line.

First, create a Mamdani FIS, specifying its name.
fis = mamfis('Name',"tipper");
Add the first input variable for the service quality using addInput.

fis = addInput(fis, [0 10], 'Name',"service");
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Add membership functions for each of the service quality levels using addMF. In this case,
use Gaussian membership functions. For more information on Gaussian membership
function properties, see gaussmf.

fis = addMF(fis, "service","gaussmf",[1.5 0], 'Name', "poor");
fis = addMF(fis, "service","gaussmf",[1.5 5], 'Name', "good");
fis = addMF(fis, "service","gaussmf",[1.5 10], 'Name', "excellent");

Add the second input variable for the food quality, and add two trapezoidal membership
functions. For information on trapezoidal membership functions, see trapmf.

fis = addInput(fis, [0 10], 'Name',"food");
fis = addMF(fis,"food","trapmf",[-2 @ 1 3], 'Name',"rancid");
fis = addMF(fis,"food","trapmf",[7 9 10 12], 'Name', "delicious");

Add the output variable for the tip, and add three triangular membership functions. For
more information on the triangular membership function, see trimf.

fis = addOutput(fis, [0 30], 'Name', "tip");

fis = addMF(fis,"tip","trimf",[0 5 10], 'Name', "cheap");

fis = addMF(fis,"tip","trimf",[10 15 20], 'Name', "average");
fis = addMF(fis,"tip","trimf",[20 25 30], 'Name', "generous");

Specify the following three rules for the FIS as a numeric array:

1 If (service is poor) or (food is rancid), then (tip is cheap).
2 If (service is good), then (tip is average).

3 If (service is excellent) or (food is delicious), then (tip is generous).

Each row of the array contains one rule in the following format.

* Column 1 - Index of membership function for first input

* Column 2 - Index of membership function for second input
* Column 3 - Index of membership function for output

* Column 4 - Rule weight (from 0 to 1)

* Column 5 - Fuzzy operator (1 for AND, 2 for OR)

For the membership function indices, indicate a NOT condition using a negative value.
For more information on fuzzy rule specification, see addRule.
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Add the rules to the FIS.

fis = addRule(fis, rulelList);

Alternatively, you can create the fuzzy inference system using a combination of dot
notation and fisvar, fismf, and fisrule objects. This method is not a good practice
for most applications. However, you can use this approach when your application requires
greater flexibility in constructing and modifying your FIS.

Create the fuzzy inference system.
fis = mamfis('Name', 'tipper');

Add and configure the first input variable. In this case, create a default fisvar object
and specify its properties using dot notation.

fis.Inputs(l) = fisvar;
fis.Inputs(1l).Name = "service";
fis.Inputs(l).Range = [0 10];

Define the membership functions for the first input variable. For each MF create a fismf

object, and set the properties using dot notation.

fis.Inputs(1l).MembershipFunctions(1l) = fismf;
fis.Inputs(1l).MembershipFunctions(1).Name = "poor";
fis.Inputs(1l).MembershipFunctions(1l).Type = "gaussmf";
fis.Inputs(1l).MembershipFunctions(1l).Parameters = [1.5 0];
fis.Inputs(1l).MembershipFunctions(2) = fismf;
fis.Inputs(1l).MembershipFunctions(2).Name = "good";
fis.Inputs(1l).MembershipFunctions(2).Type = "gaussmf";
fis.Inputs(1l).MembershipFunctions(2).Parameters = [1.5 5];
fis.Inputs(1l).MembershipFunctions(3) = fismf;
fis.Inputs(1l).MembershipFunctions(3).Name = "excellent";
fis.Inputs(1l).MembershipFunctions(3).Type = "gaussmf";
fis.Inputs(1l).MembershipFunctions(3).Parameters = [1.5 10];

Add and configure the second input variable. For this variable, specify the name and

range when you create the fisvar object.

fis.Inputs(2) = fisvar([0 10], 'Name', "food");
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Specify the membership functions for the second input. For each MF, specify the name,
type, and parameters when you create the fismf object.

fis.Inputs(2).MembershipFunctions(1l) = fismf("trapmf",[-2 0 1 3],...
"Name', "rancid");
fis.Inputs(2).MembershipFunctions(2) = fismf("trapmf",[7 9 10 12],...
"Name', "delicious");
Similarly, add and configure the output variable and its membership functions.
fis.Outputs(l) = fisvar([0 30], 'Name',"tip");

In this case, specify the output membership functions using a vector of fismf objects.

mfl = fismf("trimf",[0@ 5 10], 'Name',"cheap");

mf2 = fismf("trimf",[10 15 20], 'Name', "average");
mf3 = fismf("trimf",[20 25 30], 'Name', "generous");
fis.Outputs(

1) .MembershipFunctions = [mfl mf2 mf3];

Create the rules for the fuzzy system. For each rule create a fisrule object. Then,
specify the rules using a vector of these objects. When creating a fisrule object using
numeric values, you must specify the number of inputs variables.

rulel = fisrule([1 11 1 21,2);
rule2 = fisrule([2 0 2 1 11,2);
rule3 = fisrule([3 2 3 1 21,2);
rules = [rulel rule2 rule3];

Before adding your rules to your fuzzy system, you must update them using the data in
the FIS object. Update the rules using the update function, and add them the fuzzy
system.

rules = update(rules,fis);
fis.Rules = rules;

When constructing your fuzzy system, you can also specify custom membership functions
and inference functions. For more information, see “Build Fuzzy Systems Using Custom
Functions” on page 2-50.

Evaluate Fuzzy Inference System

To evaluate the output of a fuzzy system for a given input combination, use the evalfis
command. For example, evaluate fis using input variable values of 1 and 2.

evalfis(fis,[1 2])



See Also

ans =

5.5586

You can also evaluate multiple input combinations using an array where each row
represents one input combination.

inputs = [3 5;
2 7;

3 1]1;
evalfis(fis,inputs)

ans =
12.2184

7.7885
8.9547

See Also

evalfis | gensurf |mamfis | plotfis |plotmf |sugfis

More About

. “What Is Mamdani-Type Fuzzy Inference?” on page 2-4
. “Build Fuzzy Systems Using Fuzzy Logic Designer” on page 2-14
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Build Fuzzy Systems Using Custom Functions

2-50

Build Fuzzy Inference Systems Using Custom Functions in
Fuzzy Logic Designer

When you build a fuzzy inference system, as described in “Fuzzy Inference Process” on
page 1-28, you can replace the built-in membership functions, inference functions, or both
with custom functions. In this section, you learn how to build a fuzzy inference system
using custom functions in the Fuzzy Logic Designer app.

To build a fuzzy inference system using custom functions in the Fuzzy Logic Designer
app:

1 Open Fuzzy Logic Designer. At the MATLAB command line, type:

fuzzylLogicDesigner

2 Specify the number of inputs and outputs of the fuzzy system, as described in “The
Fuzzy Logic Designer” on page 2-17.

3 Create custom membership functions, and replace the built-in membership functions
with them, as described in “Specify Custom Membership Functions” on page 2-51.

Membership functions define how each point in the input space is mapped to a
membership value between 0 and 1.

4 Create rules using the Rule Editor, as described in “The Rule Editor” on page 2-30.

Rules define the logical relationship between the inputs and the outputs.

5 Create custom inference functions, and replace the built-in inference functions with
them, as described in “Specify Custom Inference Functions” on page 2-57.

Inference methods include the AND, OR, implication, aggregation, and defuzzification
methods. This action generates the output values for the fuzzy system.

The next figure shows the tipping problem example where the built-in Implication,
Aggregation and Defuzzification functions are replaced with the custom functions,
customimp, customagg, and customdefuzz, respectively.
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4| Fuzzy Logic Designer: tipper E\@
File Edit View
. tipper
service
/ (mamdanl}
XX tip
food
FIS Name: tipper FIS Type: mamdani
And method — - Current Variable
Or method max - || MName
L Type
Implication customimp -
............................................... Range
Aggregation customagg -
Defuzzification customdefuzz =+ Help Close
Changing aggMethod to "customagg™

6 Select View > Surface to view the output of the fuzzy inference system in the
Surface Viewer, as described in “The Surface Viewer” on page 2-35.

Specify Custom Membership Functions

You can create custom membership functions and use them in the fuzzy inference
process. The values of these functions must lie between 0 and 1. For more information on
the properties of membership functions, see “Membership Functions” on page 1-14.

To create a custom membership function, and replace the built-in membership function:

1 Create a MATLAB function, and save it in your current working folder.

To learn how to create MATLAB functions, see “Scripts vs. Functions” (MATLAB).
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The following code is an example of a multistep custom membership function,
custmfl, that depends on eight parameters between 0 and 10.

% Function to generate a multi-step custom membership function
% using 8 parameters for the input argument x
function out = custmfl(x,params)

for i = 1l:length(x)
if x(i) < params(1)

y(i) = params(1);
elseif x(i) < params(2)
y(i) = params(2);
elseif x(i) < params(3)
y(i) = params(3);
elseif x(i) < params(4)
y(i) = params(4);
elseif x(i) < params(5)
y(i) = params(5);
elseif x(i) < params(6)
y(i) = params(6);
elseif x(i) < params(7)
y(i) = params(7);
elseif x(i) < params(8)
y(i) = params(8);
else
y(i) = 0;
end
end

out = 0.1*y'; % Scale the output to lie between 0 and 1.
2 Open the Fuzzy Logic Designer app.

fuzzylLogicDesigner

The Fuzzy Logic Designer opens with the default FIS name, Untitled, and
contains one input, inputl1, and one output, outputl.

3 In the Fuzzy Logic Designer, select Edit > Membership Functions to open the
Membership Function Editor.

Three triangular-shaped membership functions for input1 are displayed by default.
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4

|4 Membership Function Editor: Untitled

File Edit View

FIS Variables

inputl  outputi
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Membership function plots IS
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mf2
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input variable “input®

Current Variable
Name

Type

Range

Display Range

input1

input

[0 1]

(0]

Current Membership Function (click on MF to select)
Name mf
Type trimf
Params [-0.4 00.4]
Help Close

Ready

To replace the default membership function with a custom function in the

Membership Function Editor:

Select Edit > Remove All MFs to remove the default membership functions for

inputl.

Select Edit > Add Custom MF to open the Custom Membership Function dialog

box.
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5

4| Custom Mermbership Function EI@

Add customized membership function

WF name mfl

W-File function name trimf

Parameter list [00.51]

oK | Cancel |

To specify a custom function, in the Custom Membership Function dialog box:

In the MF name field, specify a name for the custom membership function.

Note When adding additional custom membership functions, specify a different
MF name for each function.

In the M-file function name field, specify the name of the custom membership
function file.

In the Parameter list, specify a vector of parameters.

These values determine the shape and position of the membership function, and
the function is evaluated using these parameter values.

Note The length of the parameter vector must be greater than or equal to the
number of parameters in the custom membership function.

Using the custmfl example in step 1, the Custom Membership Function dialog
box looks similar to the following figure.
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4| Custom Mermbership Function EI@

Add customized membership function

MF name customiF1

W-File function name custm

Parameter list 0124689 1U]|

oK | Cancel |

d Click OK to add the custom membership function.

e Specify both the Range and Display Range to be [0 10] to match the range of
the custom membership function.

The Membership Function Editor displays the custom membership function plot.
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not a default mf type

This action also adds the custom membership function to the Rule Viewer, and makes
it available for creating rules for the fuzzy inference process. To view the custom
function in the Rule Viewer, select Edit > Rules in either the Fuzzy Logic Designer
or the Membership Function Editor.
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6 To add custom membership functions for outputl, select it in the Membership
Function Editor, and repeat steps 4 and 5.

You can also add a custom membership function to a FIS at the MATLAB command line.
For example, to add custmf1 to the first input variable, input1l of the FIS, myFIS, and
name it customMF1, type the following:

myFIS = addMF(myFIS, "inputl","custmfl",[0 1 2 4 6 8 9 10], 'Name', "customMF1");

Specify Custom Inference Functions

You can replace the built-in AND, OR, implication, aggregation, and defuzzification
inference methods with custom functions. After you create the custom inference function,
save it in your current working folder. To learn how to build fuzzy systems using custom
inference functions, see the “Build Fuzzy Inference Systems Using Custom Functions in
Fuzzy Logic Designer” on page 2-50 section.
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The guidelines for creating and specifying the functions for building fuzzy inference
systems are described in the following sections.

* “Create Custom AND and OR Functions” on page 2-58

* “Create Custom Implication Functions” on page 2-59

* “Create Custom Aggregation Functions” on page 2-60

* “Create Custom Defuzzification Functions” on page 2-61

» “Steps for Specifying Custom Inference Functions” on page 2-61

Create Custom AND and OR Functions

The custom AND and OR inference functions must operate column-wise on a matrix, in
the same way as the MATLAB functions max, min, or prod.

For a row or column vector X, min(x) returns the minimum element.

x =[12 3 4];
min(x)

ans =
1

For a matrix x, min(x) returns a row vector containing the minimum element from each
column.

x=1[1234;567 8;9 10 11 121;
min(x)

ans =
1 2 3 4

For N-D arrays, min(x) operates along the first non-singleton dimension.

The function min(x,y) returns an array that is same size as x and y with the minimum
elements from x or y. Either of the input arguments can be a scalar. Functions such as
max, and prod operate in a similar manner.

In the toolbox, the AND implication methods perform an element by element matrix
operation, similar to the MATLAB function min(x,y).

a=[12; 34];
b=1[22; 2 2];
min(a,b)
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ans

1 2
2 2

The OR implication methods perform an element by element matrix operation, similar to
the MATLAB function max(x,y).

Create Custom Implication Functions

Custom implication functions must operate in the same way as the MATLAB functions
max, min, or prod. Your custom implication function must be a T-norm fuzzy intersection
operation. For more information, see “Additional Fuzzy Operators” on page 1-21.

An implication function must support either one or two inputs because the software calls
the function in two ways:

To calculate the output fuzzy set values using the firing strength of all the rules and
the corresponding output membership functions. In this case, the software calls the
implication function using two inputs, similar to the following example:

impvals = customimp(w,outputmf)

* w — Firing strength of multiple rules, specified as an nr-by-ns matrix. Here, nris
the number of rules and ns is the number of samples of the output membership
functions.

w(:,j) = w(:,1) forallj. w(i,1) is the firing strength of the i*" rule.

* outputmf — Output membership function values, specified as an nr-by-ns matrix.
Here, nris the number of rules and ns is the number of samples of the output
membership functions.

outputmf (i, :) contains the data of the i" output membership function.

To calculate the output fuzzy value using the firing strength of a single rule and the
corresponding output membership function, for a given sample. In this case, the
software calls the implication function using one input, similar to the following
example:

impval = customimp([w outputmf])

w and outputmf are scalar values representing the firing strength of a rule and the
corresponding output membership function value, for a given sample.

2-59



2 Fuzzy Inference System Modeling

2-60

The following is an example of a bounded product custom implication function with binary
mapping T(a, b) = max{0,a+b - 1}.[1]

function y = customimp(x1,x2)

if nargin ==
% x1 assumed to be non-empty column vector or matrix.
minVal = zeros(1l,size(x1,2));
y = ones(1l,size(x1,2));

for i
y

l:size(x1,1)
max(minVal,sum([y;x1(i,:)])-1);

end
else
% x1 and x2 assumed to be non-empty matrices.
minVal = zeros(1l,size(x1,2));
y = zeros(size(x1));

for i = 1l:size(x1,1)
y(i,:) = max(minVal,sum([x1(i,:);x2(i,:)])-1);

end

Note Custom implication functions are not supported for Sugeno-type systems.

Create Custom Aggregation Functions

The custom aggregation functions must operate in the same way as the MATLAB
functions max, min, or prod and must be of the form y = customagg(x). Your custom
implication function must be a T-conorm (S-norm) fuzzy intersection operation. For more
information, see “Additional Fuzzy Operators” on page 1-21.

x is an nv-by-nr matrix, which is the list of truncated output functions returned by the
implication method for each rule. nv is the number of output variables, and nris the
number of rules. The output of the aggregation method is one fuzzy set for each output
variable.

The following is an example of a bounded sum custom aggregation function with binary
mapping S(a, b) = min{a + b, 1}. [1]

function y = customagg(x)
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maxVal = ones(1,size(x,2));
y = zeros(1l,size(x,2));

l:size(x,1)
min(maxVal,sum([y;x(i,:)1));

for i

y
end

Note Custom aggregation functions are not supported for Sugeno-type systems.

Create Custom Defuzzification Functions

The custom defuzzification functions must be of the formy =

customdefuzz (xmf,ymf), where (xmf,ymf) is a finite set of membership function
values. xmf is the vector of values in the membership function input range. ymf is the
value of the membership function at xmf.

The following is an example of a custom defuzzification function:

function defuzzfun = customdefuzz(xmf,ymf)

total area = sum(ymf);
defuzzfun = sum(ymf.*xmf)/total area;

Note Custom defuzzification functions are not supported for Sugeno-type systems.

Steps for Specifying Custom Inference Functions

After you create and save a custom inference function, specify the function in the fuzzy
inference system using the following steps:

1 In the lower-left panel of the Fuzzy Logic Designer, select Custom from the drop-
down menu corresponding to the inference method for which you want to specify the
custom function.
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'4.| Fuzzy Logic Designer: Untitled E\@

File Edit View

Untitled
(mamdani)
injpuit1 output
FIS Name: Untitled FIS Type: mamdani
And method — - Current Variable
Name
Or method —= -
T
Implication ube
Range
Aggregation
Defuzzification Help Close
System "Untitled™ 1 input, 1 output, and 0 rules

Doing so opens a dialog box where you specify the name of the custom inference

function.
2 In the Method name field, specify the name of the custom inference function, and
click OK.
4] E=8 Eol =5
Add customized imphethod
Method name custumimp|
oK Cancel
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The custom function replaces the built-in function when building the fuzzy inference
system.

Note In order to specify a custom inference function, you must first add at least one
rule to your FIS.

3 To specify custom functions for other inference methods, repeat steps 1 and 2.

You can also specify custom inference functions for a FIS at the MATLAB command line.
For example, to add a custom:

» Defuzzification method, type
myFIS.DefuzzificationMethod = "customdefuzz";

where customdefuzz is the name of the custom defuzzification function.
* Implication method, type

myFIS.ImplicationMethod = "customimp";

where customimp is the name of the custom implication function.
* Aggregation method, type

myFIS.AggregationMethod = "customagg";

where customagg is the name of the custom aggregation function.

Use Custom Functions in Code Generation

You can use custom functions in fuzzy inference systems for which you generate code. For
more information on code generation for fuzzy systems, see “Deploy Fuzzy Inference
Systems” on page 6-2.

If you use a nondouble data type for your generated code, you must propagate the data
type from the input arguments of your custom function to the output argument. For
example, the following custom aggregation function maintains the data type of x in y
using the ones and zeros with the 'like' argument.

function y = customagg(x)

maxVal = ones(1,size(x,2), " 'like',x);
y = zeros(1l,size(x,2), 'like',x);
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for i
y

l:size(x,1)
min(maxVal,sum([y;x(i,:)1));

end

For more information on writing functions that support C/C++ code generation, see
“MATLAB Programming for Code Generation” (MATLAB Coder).
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Fuzzy Trees

As the number of inputs to a fuzzy system increases, the number of rules increases
exponentially. This large rule base reduces the computational efficiency of the fuzzy
system. It also makes the operation of the fuzzy system harder to understand, and it
makes the tuning of rule and membership function parameters more difficult. Because
many applications have a limited amounts of training data, a large rule base reduces the
generalizability of tuned fuzzy systems.

To overcome this issue, you can implement a fuzzy inference system (FIS) as a tree of
smaller interconnected FIS objects rather than as a single monolithic FIS. These fuzzy
trees are also known as hierarchical fuzzy systems because the fuzzy systems are
arranged in hierarchical tree structures. In a tree structure, the outputs of the low-level
fuzzy systems are used in high-level fuzzy systems. A fuzzy tree is more computationally
efficient and easier to understand than a single FIS with the same number of inputs.

Types of Hierarchical Structures
There are several fuzzy tree structures that you can use for your application. The

following figure shows commonly used fuzzy tree structures: an incremental, aggregated,
or cascaded structure.
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Incremental Structure

In an incremental structure, input values are incorporated in multiple stages to refine the
output values in several levels. For example, the previous figure shows a three-level
incremental fuzzy tree having fuzzy inference systems FIS]', where i indicates the index of

a FIS in the nth level. In an incremental fuzzy tree, i = 1, meaning that each level has only
one fuzzy inference system. In the previous figure, the jth input of the ith FIS in the nth
level is shown as input x;;n, whereas the kth output of the ith FIS in the nth level is shown

as input xn. In the figure, n = 3,j =1 or 2, and k = 1. If each input has m membership
functions (MFs), each FIS has a complete set of m? rules. Hence, the total number of rules
isnm? =3[3%=27.

The following figure shows a monolithic (n = 1) FIS with four inputs (j=1, 2, 3, 4) and
three MFs (m = 3).
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In the FIS of this figure, the total number of rules is nm* = 1 [] 3% = 81. Hence, the total
number of rules in an incremental fuzzy tree is linear with the number of input pairs.

Input selection at different levels in an incremental fuzzy tree uses input rankings based
on their contributions to the final output values. The input values that contribute the most
are generally used at the lowest level, while the least influential ones are used at the
highest level. In other words, low-rank input values are dependent on high-rank input
values.

In an incremental fuzzy tree, each input value usually contributes to the inference process
to a certain extent, without being significantly correlated with the other inputs. For
example, a fuzzy system forecasts the possibility of buying an automobile using four
inputs: color, number of doors, horse power, and autopilot. The inputs are four distinct
automobile features, which can independently influence a buyer’s decision. Hence, the
inputs can be ranked using the existing data to construct a fuzzy tree, as shown in the
following figure.

color —
fis] —
doors —= fisl/output] |
—_————————
fis2/inputl|
[f1s2|
Ifie2f
e [fis2/output]
sdinputl| = 5| & i
| fisd/inputl = a1 prediction
autopilot
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For an example that illustrates creating an inc